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1. Introduction

1.1. Implementation Guide

The Implementation Guide provides technical information for the implementation of the Clinical
Procedures Flowsheets Module. This document provides guidance for Information Resource Management
(IRM) technical personnel, Clinical Application Coordinators (CACSs), and Flowsheet Coordinators to
implement and operate the software. More information can be found in the Clinical Procedures (CP) V1.0
Flowsheets Module User Manual.

1.2. Product Benefits

The Clinical Flowsheets patch of the Clinical Procedures (CP) package provides an electronic
representation of the traditional paper flowsheet maintained during each inpatient stay. Vitals,
Intake/Output, and Wound Documentation are examples of data types that can be recorded via Clinical
Flowsheets into the Veterans Health Information System and Technology Architecture (VistA) system.
Clinical Flowsheets provides a departure from its predecessor applications by storing collected
information as discrete data. Some date elements, such as vital signs, are available to the Vitals Package
and Computerized Patient Record System (CPRS). Various reports built on the other data elements are
available for CPRS in the form of Text Integration Utilities (TIU) Notes. Additionally, flowsheets is a
tool that can be used by clinicians to standardize assessment templates.

There are two ways to enter data into Clinical Flowsheets: manually and via Health Level 7 (HL7)
messaging. Any instrument or external system capable of sending HL7 messages can be considered a
source of data for Clinical Flowsheets (provided that the HL7 messages conform to Clinical Flowsheets
requirements).

Clinical Flowsheets uses VistA Data Extraction Framework (VDEF) support, HL7 messaging, and the CP
Gateway service to notify the medical device of the patient’s admission, discharge, and transfer.

MD*1.0*16 consists of the following three windows executables components and one Kernel Installation
& Distribution System (KIDS) build:

e CPConsole.exe
e CPFlowsheets.exe
o CPGatewayService.exe

e MD1 0P16.KID

1.2.1. CP Gateway Service

The CP Gateway Service is the component that processes HL7 messages.

The CP Gateway Service is composed of two subsystems, one existing solely within VistA, and the other
existing as a Windows service that interacts with VistA via the Remote Procedure Call (RPC) Broker. A

vendor device sends an observation to VistA inside an HL7 (ORU”R01) inbound message. The message

is received by the VistA HL7 system, the patient and device are validated, and it is then forwarded to the
Windows-based CP Gateway Service subsystem.
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The VistA CP Gateway Service subsystem parses and validates the patient-identifying information and
the device identifier. If the patient information and device identifiers are valid, the Windows service is
notified that there is a message waiting to be processed in VistA. The Windows service calls into VistA
via the RPC Broker to retrieve the HL7 message. The Windows service then parses and validates the
observation data and saves the validated information in the Clinical Observations database (CliO) data
store.

A Microsoft Windows service was used so that, in the next iteration of CliO, it will be possible to build in
the ability to parse and decode images encoded in HL7 messages. Using a Microsoft Windows service
also allows the processing of observational data to be offloaded to a second processor, allowing the
primary listening process in the HL7 subsystem in VistA to be more responsive.

/—ViSU—\ \
Validates Patient -
Identifying
Information and
determines Parsed observational Parses
message source information observational
device ID information.
Ultimately, will
parse and
translate images
in subsequent
iteration.
Not!ﬂcanon
) of available data
VistA HL7 subsystem [
ORU”MRO1L and CP routines Retrieves data —
and terminology | —
HL7 Gateways —
and 3" party devices ¢ =
—

CP Gateway Service

Figure 1-1 CP Gateway Service

For more information about the CP Gateway Service, refer to the CP V1.0 Flowsheets Module
Installation Guide.

1.2.2. CliO Database

The CIiO database provides a standardized terminology data store for all clinical observations throughout
the Department of Veterans Affairs (VA).

1.2.3. Terminology Mapping

The CP Gateway Service provides extensive terminology mapping which translates proprietary labels so
the information is understood to represent the same thing and, thus, be stored appropriately. Devices do
not always use the same terms to describe the data they transmit. For example, one device may use the
term “heart rate,” while another may transmit the same information as “pulse.” This mapping is more
efficient than trying to compel each medical device vendor to conform to using standard terminology.

Similarly, CP Flowsheets can display the data to the user using the terminology that is preferred at a given
unit or medical center. A flowsheet used by an MICU unit at one hospital can be customized to display
“Heart Rate,” while a flowsheet used by a step-down unit may display “HR” or “Pulse.”

August 2011 Clinical Procedures (CP) Flowsheets Module V1.0 7
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1.3. CP Flowsheets

CP Flowsheets provides an electronic representation of the traditional paper flowsheet. This user-
friendly, customizable Graphical User Interface (GUI) provides functionality for data entry, validation
and editing, as well as patient management.

o Flowsheets provides electronic flowsheets that can be custom designed for any clinical area of a
Medical Center.

o Flowsheets is a tool that can be used by clinicians to standardize assessment templates
nationwide.

e Flowsheets provides the ability to report discreet observations data combined with progress notes.

o Flowsheets creates a complete audit trail of patient documentation.

1.4. CP Console

CP Console provides the tools to build the flowsheet views and layouts that are used for patient care, for
recording vital statistics as necessary. It also provides a means for configuring the CP Gateway Service,
assigning permissions to CP Flowsheets users, and system administration.

1.5. Intended Audience

This Implementation Guide is intended for use by Information Resource Support personnel, CACs, and
Flowsheet Coordinators. End users should be familiar with the following:

¢ Windows operating systems
e CPRS functionality

1.6. CP Console Implementation

CP Console is the administration dashboard for implementing and maintaining Clinical Flowsheets and
devices for Clinical Procedures. Information Resource Management (IRM) should grant the site’s
flowsheet coordinator the MD ADMINISTRATOR key. CP Console is then used to set up views,
flowsheets, flowsheet totals, instruments, shifts, scheduled cleanup of unused files, and all the other
administrative tasks to customize the application for their site.

8 Clinical Procedures (CP) Flowsheets Module V1.0 August 2011
Implementation Guide



This page intentionally left blank for double-sided printing

August 2011 Clinical Procedures (CP) Flowsheets Module V1.0
Implementation Guide



Pre-Implementation Planning

2. Pre-Implementation Planning

2.1. General Guidance

To begin the pre-implementation planning, it is recommended that Medical Center Management support a
Clinical Flowsheets Focus Group comprised of representatives from the Chief of Staff’s office, IRM,
Nursing, Labor Management, Quality Management, Health Information Management Service (HIMS)
and Biomedical Engineering. The focus group would discuss the order of implementation in the facility,
new process and procedures for documenting using electronic flowsheets, as well as the third party
vendor devices, such as bedside monitors and Clinical Information Systems that may be used
in/purchased for Critical Care areas. Additionally, this group would drive the design of the flowsheets as
this is site configurable.

This software can be implemented one unit at a time. As with any new software, new processes and
procedures are required. For Clinical Flowsheets to be effective and successful, all transactions need to
be entered and documented electronically.

2.2. Software

The CP Clinical Flowsheets product, MD*1*16, was released with the following components:
File Name Contents

MD1 P16.KID MD*1.0*16 KIDS Build

MD1 0P16 Sample Views.xmi Sample Views

MD1_0P16CPGatewayServiceSetup.exe MD*1.0*16 CP Gateway Service setup file
MD1_0P16_EXES_AND_DOC.zip 12 files indented below

-CliO_Terminology.doc MD*1.0*16 Clinical Flowsheets Terminology file
-CPConsole.cnt MD*1.0*16 CP Console online Help contents file
-CPConsole.exe MD*1.0*16 CP Console Executable

-CPConsole.hlp MD*1.0*16 CP Console online Help file
-CPGatewayService.exe MD*1.0*16 CP Gateway Service Executable

-MD_1 P16.KID MD*1.0*16 KIDS Build

-MD_1 P16_IG.pdf MD*1.0*16 Clinical Procedures (CP) V1.0 Flowsheets Module

Installation Guide

-MD_1 _P16_IMPG.pdf MD*1.0*16 Clinical Procedures (CP) V1.0 Flowsheets Module
Implementation Guide

-MD_1 P16 _RN.pdf MD*1.0*16 Clinical Procedures (CP) V1.0 Flowsheets Module
Release Notes

10 Clinical Procedures (CP) Flowsheets Module V1.0 August 2011
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-MD_1 P16_TM.pdf MD*1.0*16 Clinical Procedures (CP) Technical Manual and
Package Security Guide
-MD_1 _P16_UM.pdf MD*1.0*16 Clinical Procedures (CP) V1.0 Flowsheets Module
User Manual
-RoboEx32.dll .DLL file required to access Help files
MD1_0P16_Flowsheets.zip (includes the 4 files indented below)

Note: This file is available upon request from the implementation team.

-CPFlowsheets.exe MD*1.0*16 CP Flowsheets Executable
-CPFlowsheets.hlp MD*1.0*16 CP Flowsheets online Help file
-CPFlowsheets.cnt MD*1.0*16 CP Flowsheets online Help contents file
-RoboEx32.dlI .DLL file required to access Help files

Upon release of the CP Clinical Flowsheets product, the sites have three choices:

a.

If the site is not currently running Clinical Procedures, only the KIDS build needs to be installed.
All other installation instructions and post-installs can be ignored.

If the site is running Clinical Procedures and does not plan on implementing Clinical Flowsheets
at this time, only the KIDS and CP console (replacement for CP Manager) need to be installed.

Note: Once you install the KIDS and CP console components, CP Manager will not function.

C.

If the site is running Clinical Procedures and chooses to begin the implementation of Clinical
Flowsheets, then all four components need to be installed: KIDS, CP Console, CP Flowsheets and
the new CP Gateway service.

Once the decision is reached to begin the implementation of Clinical Flowsheets, the applications
coordinator for this product will need to notify their Information Resource Management (IRM)
service and verify what level of implementation they are at for Clinical Procedures. IRM will
need to apply the CP Console and/or CP Gateway Service as applicable depending on their
current status.

The CP Flowsheets.exe is not included within MD*1*16 as this executable is an optional and
controlled roll out, managed by the Implementation Manager. A readiness checklist will be
provided by the Implementation Manager when the site requests the CP Flowsheets.exe.

To request the CP Flowsheets.exe, contact VA OIT OED ClinProc Implementation Support.

August 2011 Clinical Procedures (CP) Flowsheets Module V1.0 11
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2.3. Flowsheet Design

The CP Console provides the tool to build the flowsheet views and layouts. In the pre-
implementation phase, a copy of the current paper flowsheet should be reviewed. The design of
the electronic flowsheets can then be established based on the review.

Sample Views are available for import. A copy of these views can be made once imported onto
your system, and the copy can then be edited so that it is customized for your facility. You can
also create a view from scratch.

CP Flowsheets are built from the CP Views. You can apply the same view to many flowsheets.
It is important to remember this because if an edit is done on a CP View, that edit will be
reflected on all the CP flowheets that have that CP view assigned.

2.4. Flowsheet Coordinators

The facility will need to determine who will have access to build the views and flowsheets. IRM
will need to assign permissions as requested. Additional information about permissions is
available in Chapter 3: CP Console Overview.

The Flowsheet Coordinator should be given the MD ADMINISTRATOR key, which will give
them permissions to all needed functions.

The Flowsheet Coordinator has the following key responsibilities:

e Manages and facilitates installation, implementation, maintenance, enhancements
and overall use of CP Flowsheets throughout the medical center through ongoing
needs assessments and evaluation processes.

e Serves as site coordinator for implementation and development teams at the
facility level, including communication of issues with the executive stakeholders
and program team to achieve resolution

e Serves as a liaison to the VISN and national level teams for the CP Flowsheet
application, to include facility representation at conference calls
and/or educational programs.

e Coordinates and ensures initial and ongoing training for all CP Flowsheet users,
including students, and temporary staff.

e Coordinates and ensures initial and ongoing usability assessments for the CP
Flowsheet application and hardware systems.

e Facilitates initial and ongoing contingency system management.

2.5. Contingency Plans

Contingency procedures should be developed for scheduled and unscheduled downtime and
coordinated with stakeholders prior to the implementation of the software. All applicable staff
will need to be trained on the contingency plans.

12 Clinical Procedures (CP) Flowsheets Module V1.0 August 2011
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Customizing Flowsheets

3. CP Console Overview

CP Console is a replacement for CP Manager.

The CP Console window contains the following elements:
e Menu Bar
e Button Bar
o Detail Area
e Tree View

/42 CP Console |:||E|E|

Filz Tools Help

1 saarch ...

[E=1CP Console Item Name: <Mo Item Selected>

Type:
Access Leve

WILDER, RACHEL (22222237 HIMES ISC (57 Wists RPC Broker - HINES@!

Figure 3-1, CP Console Window

Note: MD*1.0*16 disables the use of CP Manager. Use CP Console to perform the functions
previously provided by CP Manager.

14 Clinical Procedures (CP) Flowsheets Module V1.0 August 2011
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3.1. CP Console Menu Bar

The CP Console Menu bar appears along the top of the window, under the Windows title bar. It contains
three menu options: File, Tools, and Help.

A~ CP Console

File Tools Help

Figure 3-2, CP Console Menu Bar

3.1.1. File Menu

Use the File menu to add new items, rename existing items, delete items, save items, and exit CP

Console.
# CP Console

. |File | Tools Help

et 3

E Save ...

B Make Copy ...
Exit !

Figure 3-3, File Menu
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Implementation Guide

15



Customizing Flowsheets

3.1.1.1. New Menu

The New menu option allows you to create new flowsheets, flowsheet views, flowsheet totals, schedules,

and shifts, as well as add instruments and procedures.

/4 CP Console

. |Filz | Tools Help
: | e * [ BEH FHowshest
— %  Flowsheet Tokal
. 7 Flowsheet Yiew
EH save.. B Instrument
B Procedure
Exit [ schedule
; TSI ETTIETTE
5 FParameters @ shift

Figure 3-4, New Menu
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3.1.1.2. Renaming an Item in the Tree View

Use Rename to change the name of an item in the tree view. To rename a flowsheet, a flowsheet total, a
flowsheet view, an instrument, a procedure, or a shift, complete the following steps:

1. Inthe CP Console tree view, select an item. The worksheet for that item appears.
2. Click File and select Rename. The Rename <item> pop-up appears.

Rename Flowsheet @

New MName:

BJE Y FLOWSHEET]

[ OK ][ Cancel

Figure 3-5, Rename Flowsheet
3. Type a new name.

4. Click OK. The new name appears in the tree view.

3.1.1.3. Deleting an Item

Use the Delete option to remove an item from the tree view. To delete a flowsheet, a flowsheet total,
configuration parameters, or a shift, complete the following steps:

You can also delete items from the CP Console button bar.

- P Rrename X Delete ... Y Search ... 2 Permissions ...

Figure 3-6, CP Console Button Bar

Note: Since a Flowsheet is simply a data entity form, deleting a Flowsheet does not give you the ability to
delete patient data,. If you remove a term, view, or flowsheet, data still exists but is no longer viewable
within Flowsheets.

1. Inthe CP Console tree view, select an item. The worksheet for that item appears.

2. Click File and select Delete. The Confirm pop-up appears.

Confirm

Are you sure you want to delete
»\0/ Flowsheet: 'Flowsheet 3'?

[ Yes H Mo ]

Figure 3-7, Confirm Delete
3. Click Yes. The item is removed from the tree view.

August 2011 Clinical Procedures (CP) Flowsheets Module V1.0 17
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Note: From the File menu, you can select Save to retain your additions and changes.

4, Select Exit to close CP Console.

3.1.2. Tools Menu

Use the Tools menu to locate items, assign permissions, refresh user roles, and export and import

flowsheet views.

Note: If you make a change in CP Console, you will not see the change until you reload the Flowsheet.

#+ CP Console

3.1.2.1. Search

- File

- &R

==
=

Tools | Help

- Search ...

@ Permissions ...
ﬁ Fefresh Roles
g Export To ML ...
+*

= Irmport From XML ..,

Fi

gure 3-8, Tools Menu

On the Tools menu, click Search to look for an item in CP Console, such as a view, instrument, or
procedure. Use the Console Find It Utility to perform your search.

Console Find It Utility

Search For:

Search Results

Search >>

Figure

3-9, Console Find It Utility
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3.1.2.2. Working with User Permissions

Use the Permissions option to add, remove, and modify users to items in the Tree view (i.e. View,
Flowsheet, etc.) of Flowsheets and assign permissions (access) to those items. Any user with the MD
ADMINISTRATOR key can assign permissions to any of the items in CP Console. Other users can
assign permissions only to the items that they own/control. Security keys assigned to each user determine
the overall access they have to CP Console (Refer to the Refresh Roles section for more details).
Assigning permissions is a way of giving access to a user who would otherwise not have access to a
specific item in the Tree view.

Note: You need MD ADMINISTRATOR to assign any permission to any object or you need to have full
access granted to you for items you are assigning to another person.

Highlight the item in the Tree view that you want to give another user permission to configure.

On the Tools menu, click Permissions or click the Permissions button. The Access Control List
Manager appears and displays the users and permissions for the highlighted item.

Access Control List Manager
Permissions

1D: {144709B1-DE1B-4464-870F-3E9490A2C371}
Name: NEW FLOWSHEET

Users:

[ add.. ][ remove |

Permissions:

Figure 3-10, Access Control List Manager

Use the Access Control List Manager to add users and their permissions, to change permissions, and to
remove users. The Access Control List Manager offers a choice of four permissions that you can assign to
a user:

e Read-Only - can only read items (default)

e Read-Write - can read, edit, and save items

e Read-Write-Delete - can read, edit, and save items, as well as delete some items
¢ Full Control - can do everything, which includes adding and removing users

August 2011 Clinical Procedures (CP) Flowsheets Module V1.0 19
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3.1.2.3. Adding a User and Permissions

Use the Access Control List Manager to add users and permissions. To add users and permissions for an
item in the Tree view:

1. Select the item from the Tree view.

2. On the Tools menu, click Permissions or click the Permissions button. The Access Control List
Manager appears.

3. Click Add. The Person Lookup pop-up appears.
Use the Person Lookup to locate the user you want to add or remove, or change the user’s

permissions.
Mame:
Select One:
Figure 3-11, Person Lookup

4. On Person Lookup, type a letter or two in the Name box.
5. Click Search.
6. Select a user from the Select One list.
7. Click OK.
8. Highlight the user in the Users list.
9. Select an option from the Permissions list.

10. Click Update.
11. Click OK.

3.1.2.4. Changing a User Permission

Use the Access Control List Manager to change the permissions of users. To change permissions for an
item on the Tree view:

1. Select the item from the Tree view.

2. On the Tools menu, click Permissions or click the Permissions button. The Access Control List
Manager appears.

3. Select a user from the Users list.

20 Clinical Procedures (CP) Flowsheets Module V1.0 August 2011
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4. Select an option from the Permissions list.
5. Click Update.
6. Click OK.

3.1.2.5. Removing a User Permission

Use the Access Control List Manager to remove users. To remove a user for an item on the Tree view:
1. Select the item from the Tree view.

2. On the Tools menu, click Permissions or click the Permissions button. The Access Control List
Manager appears.

Select a user from the Users list.
4, Click Remove.
Click OK.

3.1.2.6. Refresh Roles

Refresh Roles retrieves the current role (security key) assignments in VistA for the current user and
displays them.

To refresh roles, complete the following steps:

1. From the Tools menu, select Refresh Roles and the Information pop-up appears with the roles
assigned to the item selected.

Information X

j) User Roles refreshed 6/24/2010 10:39:19 AlM,

WD ADMIMISTRATOR: Assigned
WD MANAGER: Assigned

WD HLY MAMNAGER: Assigned
WD READ-0MNLY: Mot Assigned
WD TRAIMEE: Mot Assigned

Figure 3-12, User Roles Assigned to Selected Item

e MD ADMINISTRATOR — CP Console requires the VistA MD ADMINISTRATOR role to create
items in CP Console. The MD ADMINISTRATOR role includes MD MANAGER abilities with
additional capabilities. CP Flowsheets requires the VistA MD ADMINISTRATOR role or the MD
HL7 MANAGER role to access the HL7 Monitor. This role allows the holder full control of CP
Flowsheets. Assign this role to users responsible for setting up and maintaining CP Console and CP
Flowsheets.

e MD MANAGER - This role allows the holder to edit, audit, or rescind someone else’s data. Assign

this role to power users of the CP Flowsheets patch to give them enhanced capabilities over a basic
Flowsheets user.
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e MD HL7 MANAGER - CP Flowsheets requires the VistA MD HL7 MANAGER role or the MD
ADMINISTRATOR role to access the HL7 Monitor. Assign this role to a user who will assist with
the HL7 messaging component of CP Flowsheets.

e MD READ-ONLY - Assign this role to a user to prevent them from entering data in Flowsheets. DO
NOT assign MD READ-ONLY to a user concurrently with any role other than MD HL7
MANAGER. Doing so will lead to unpredictable results. A user with the MD READ-ONLY key
may NOT log on to CP Console and will have limited functionality in CP Flowsheets.

e MD TRAINEE - This role has the same capabilities as a basic user except that all observations are
unverified; a user who is not a trainee must verify all trainee observations. Assign this role to trainees.

3.1.2.7. Export to XML

Export to XML allows you to save your Instruments, Procedures, or Views to a disk as a backup of your
flowsheet layouts. This allows administrators to share views or Flowsheets with other users or sites. To
export to XML, complete the following steps:

Note: You must be assigned the role of MD ADMINISTRATOR to use this function.
1. Onthe CP Console Tools menu, click Export to XML. The CP Console Export Wizard appears.

CP Console Export Wizard

ctiniod]) Welcome to the CP Console Export
procedures Wizard

This wizard helps you to create an XML Export file for components of the CP
Console application for distribution to other installations.

To continue, click Mext.

[ Next > ] [ Cancel

Figure 3-13, CP Console Export Wizard
2. Click Next. The CP Console Export Wizard asks you to select the type of items to export.
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CP Console Export Wizard

clinical
procedures

e, Anvtme

Select the type of CP Console Ttems that you want to export.
Type of items to export:
O Instruments

() Procedures

) views

To continue, select an item type to export and dick Next.

Figure 3-14, CP Console Export Wizard Select Type

3. Select Instruments, Procedures, or Views and click Next. The CP Console Export Wizard asks you
to select the instruments, procedures, or views to export.

CP Console Export Wizard

e, Anyiime

i
clinical '
proce

The following 337 items are available for export.
Press Ctrl-A to select all items.

iAthena Hypertension

AWARE

AXIOM Sensis

AXIOM Sensis (Bi-Directional)
AXIOM Sensis (Diag. Cor, Cath)
AXIOM Sensis (EP Study)
AXIOM Sensis (Ped, Card. Int.)
AXIOM Sensis (Ped, Cor, Cath)
ERALIMN

BRALIN (Bi-Directional)
CATHCOR

CATHCOR. (Bi-Directional)
CE-MORTARA

CE-MORTARA (EKG)
CB-MORTARA (Halter)
CB-MORTARA (Stress)
CLIMIVISION

COLLINS

HE2

b

To continue, select 1 or more itemns from the list and didk Ne_xt

< Back ” Mext = ] ’ Cancel

4. Select the instruments, procedures, or views you want to export (in this example, instruments are
being exported). You may select as many as you wish. You may press Ctrl-A to select all of the

August 2011

Figure 3-15, CP Console Export Wizard
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instruments, procedures, or views. Click Next. The CP Console Export Wizard asks you to enter or
select the name of the file to export the selected instruments, procedures, or views.

CP Console Export Wizard

Export Filename:

|| Browse ...

A

clinical | |
procedures

e, Aryivne Comments (Optional):

To continue, dick Browse to select a filename and then dick Next.

Figure 3-16, Export Filename and Comments

5. Export Filename and Comments.
e. Enter the name of the export file. To change the location where the file will be saved, click
Browse and select the location.

Or:
To replace an existing file with the new export file, or click Browse and select the file to replace.

Click Yes when prompted to replace the file.

f. Optionally, you may add comments in the Comments box. Comments submitted in the Export
Wizard will appear in the Import Wizard before you finish importing your views. These will be
included in the XML export file.

g. Click Next. The CP Console Export Wizard displays a preview of the XML file.
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CP Console Export Wizard

Export Document Preview:

|
dlm‘;dum <?uml version="1,0"2> A
I <CP_CONSOLE_COMPOMENTS > i
<DATE_CREATED >2009-05-18 13:14:09</DATE_CREATED >
<VERSION > 1</ VERSION>

<COMMENTS =Optional comments, </COMMENTS =
<RECORD TYPE="4" ID="{0FB4D6 78-D759-4A IE-BCAB-5DES06B30CCA’
<VIEW _ID>{0FB4D673-D769-44 1E-BCAB-5DERDGBRE0CCA} < /VIEW_ID
<MNAME =Al's Vitals View 1</MNAME:=
<TIME_INTERVAL > 1440 </TIME_INTERVAL >
<X _ANIS=0<X_AXIS>
<DISPLAY _MAME=Al's Vitals View 1</DISPLAY_MAME:=
<ALLOW_PIVOT:>1</ALLOW_PIVOT>
<NATIONAL_TITLE >0 </MNATIOMAL_TITLE>
<COMMENT =Matches Vitals package < /COMMENT =
<TERMINOLOGY =
<RECORD>
<VIEW_ID>{0FB4D678-0769-4A 1E-BCAB-SDER06B80CCAT < NIEW _ o
< i | >

To continue, dick Next.

’ < Back H MNext > l’ Cancel

Figure 3-17, CP Console Export Wizard File Preview
6. You can scroll to review the XML file. To export the file, click Next.

CP Console Export Wizard

ctiniodF CP Console Export Wizard Successfully
procedures Completed!

e, Anviime

To dose this wizard, dick Finish

Figure 3-18, CP Console Export Wizard Success
7. When the export is complete, click Finish.
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3.1.2.8. Import from XML

You can import Sample views such as a method to share between sites.

3.1.3. Help Menu

The Help menu provides information about the application and access to online Help.

# CP Console
File Tools

- & Rename| ¥ Contents ..
JB sbout .

Help

= ‘3 CP Con

Figure 3-19, Help Menu
From the Help menu, select About to display information specific to the CP Console application.

Select Contents to display online Help for CP Console.

3.2. CP Console Tree View

In the left-hand panel, the CP Console tree view provides access to the following items: Background
Task, Flowsheet, Flowsheet Total, Flowsheet View, Instrument, Parameters, Procedure, Schedule, and
Shift.

5 &

+-(_7] Background Task
-] Flowsheet

-] Flowsheet Total
(7] Flowsheet View
(L] Instrument
-] Parameters
J-(_]] Procedure

1-(] Schedule

(] Shift

[ I O B B O B u

&

Figure 3-20, CP Console Tree View
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3.3. CP Console Detail Area

When you select an item in the CP Console tree view, details for that item appear in the large panel to the
right. This is the worksheet where you create, customize, and fine-tune your flowsheet views, flowsheet

layouts, and so on.

CP Console
File Tools Help

- &F Rename

, Search ...

T Permissions ..,

e

[ Flowsheet
] Flowsheet Total

] Flowsheet View
Mew CHEST TUBE

Zample A-LINE

Sample BLOOD PRODUCTS INPUT
Sample CARDIO

Sampls CENTRAL LINE
Sample CHEST TUBE

Sample DIALYSIS

sample DRAIN

Sample EMVIRONMENTAL
Sample &I

sample GLYCEMIC CONTROL
Sample GU

Sample HEMODYNAMICS
Sample TABP

sample INTAKE

Sample INTEGUMENTAR'Y
Sample IV DRIP wiMEDS
sample IV FLUIDS

sample I¥ SITE

sample NEURO

Item Name:
Type: Flowsheet Yiew

Access Level: Full Control

New CHEST TUBE

CeRerel_

o

Display Mame:

T -fixis:

Site Assessment

Drainage Characteristics
Dressing Change

Drainage System Replaced
Chest Expansion

Drainage Amount (Estimated)
Drainage Yaolume

|Sample CHEST TUBE | |4 Hours | |DatefTime List & |
gg[@ment:
EReIeased as part of a set of sample views.
[ Active Allow Pivak
Terminology
Display Mame Farmal Mame
Drainage Suckion Type CHEST TUEE DRAIMAGE SUCTION ...
Suckion CHEST TUBE SUCTION {CM H20)

CHEST TUBE SITE ASSESSMENT
CHEST TUBE DRAIMAGE CHARACT...
CHEST TUBE DRESSING CHAMGE
CHEST TUBE DRAIMAGE SYSTEMR...
CHEST EXPANSION

OUTPUT - CHEST TUBE ESTIMATED
OQUTPUT - CHEST TUBE

Sample QUTPUT
Sample P& CATH
Sample PACEMAKER
Sample PACU
Sample PATN
Sample PRESSURE ULCER
Sample PULM
sample RESTRAINT
Sample SEDATION
sample SETZURE
Sample YEMT
Sample YITALS

Figure 3-21, Item Detail Area

The banner appears at the top of every detail area, indicating the name you assign to the item, the type of
item you are creating or modifying (flowsheet, view, total), as well as the access level.
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4. Working with Clinical Flowsheet Views

The following section details the basic tasks available within CP Console.
To get started, you will need the following:

J You must have the MD ADMINISTRATOR key

. Access to the CP Console executable

J Menu Option MD CLIO must be assigned

Within CP Console, you can complete the following tasks:
e Import Sample Views
e Customize Flowsheet Views

e Create a Flowsheet

e Add, Edit, or Remove a view from an existing flowsheet

i} IMPORTANT: If you are importing views from a different site, you need to copy and

rename them. See Renaming a Copied View for more details.

See Also — Importing Views from XML, step 6. If you click yes to the CP Console Import Wizard
Confirm Warning message, your imported view will be overwritten. Make sure that you make a copy
of the existing view to retain its contents.

4.1. Importing Views from XML

Sample Views for Flowsheets are available for download. You can copy sample views as a starting point
for creating custom views. They are available on the anonymous FTP site as

MD1 0P16_ Sample_Views.xml . Contact your local IRM Support to retrieve this file from the designated
FTP server.

You can also follow these steps to import custom views.
1. Onthe CP Console Tools menu, click Import from XML. The CP Console Import Wizard appears.
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../Application%20Data/Microsoft/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/INTLQ6V7/

CP Console Import Wizard

I Welcome to the CP Console Import
proveckres Wizard

This wizard helps you to install components of the CP Console application
from other installations.

To continue, click Mext.

[ Next = ] [ Cancel

Figure 4-1, CP Console Import Wizard
2. Click Next. The CP Console Import Wizard asks you to enter or select the name of the file to import.

CP Console Import Wizard

Import Filename:

elinicﬁf“d ron | Browse ...

To continue, dick Browse to select a filename and then dick Next.

Cancel

Figure 4-2, CP Console Import Wizard Import Filename

3. Enter MD1 _0P16_Sample_Views.xml, or click Browse and select the file to import. The CP
Console Import Wizard displays the file header.

August 2011 Clinical Procedures (CP) Flowsheets Module V1.0 29
Implementation Guide



Customizing Flowsheets

CP Console Import Wizard

T T

K,
clinical "
procedures

Impaort Filename:

EC:'I,MDl_DPIEu_SampIe_\.l'iews.me [: Browse ... J
File Header Description:
Date Created: 2009-05-21 10112129
Wersion: 1.0
Components Found: 31
Comments:
Sample Wigws

To continue, click Browse ko select a filename and then click Mext.

[ < Back ” Next = J[ Cancel ]

Figure 4-3, CP Console Import Wizard File Header

4. Click Next. The CP Console Import Wizard asks you to select the components to import.

CP Console Import Wizard

30

Wi
clinical
procedures

. Arsdima

The fFollowing 31 CP components were Found.
Press Ctrl-4 to select all iterns.,

ample A-LIME Ca
mple BLOOD PRODUCTS IMPUT
ample CARDIO

ample CEMTRAL LIME

ample CHEST TUBE

ample DIALYSIS

ample DRAIN

ample EMYIROMMENTAL

ample &1

ample GLYCEMIC COMTROL s
ample U

ample HEMODYRAMICS

W
—reele T CTTE

To continug, select 1 oF more components From the lisk bo import and click Mext,

[ % Back l[ Mexk = J’ Cancel

Figure 4-4, CP Console Import Wizard Select Components

5. Press Ctrl-A to select all of the components. Click Next.
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6. If you import a view that has a Flowsheets view internal number that is the same as a view that
already exists in CP Console, the imported item will overwrite the existing item. The CP Console
Import Wizard displays a confirmation box to confirm that you want to overwrite the existing item.

Confirm

an item with ID: {175BF626-9486-0EC4-169B-ECB923904929} already exists in this account,

9
\‘“33‘) Mame: Sample A-LINE

Maote: Item may be under another name but the ID does exist and will be overwritten,

Do you want bo overwrite this item?

L es ] [ o ]

Figure 4-5, CP Console Import Wizard Confirm

WARNING! If you click Yes, it will overwrite the existing item. To import a view and still retain the
existing item, before you import the new item, make a copy of the existing item (refer to the
Making a Copy section for more details), then import the new item. The import will still overwrite
the original item, but it will not overwrite the copy.

Note: Sample Views are read-only and cannot be changed.

To confirm the import of the item, click Yes. To retain the existing item and cancel the import of the
new item, click No.

If you are importing more than one item that has a Flowsheets internal 1D that is the same as a view
that already exists in Flowsheets, the CP Console Import Wizard will display a confirmation box for
each item.

7. During the import, the CP Console Import Wizard displays a progress report of the components as
they are imported.
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CP Console Import Wizard

e, At

)
clinical "
procedures

CP Console Import Wizard Completed!

Messages:

Sample A-LINE imported,

Sample BLOOD PRODUCTS INPUT imported,
Sample CARDIO imported.,

Sample CENTRAL LINE imported.,
Sample CHEST TUBE imported,

Sample DIALYSIS imported,

Sample DRAIM imported,

Sample ENYIROMMENTAL imported,
Sample &I imported,

Sample GLYCEMIC COMTROL imported.
Sample GU imported,

Sample HEMODYMAMICS imported,
Sample TABP imported.,

Sample INTAKE imported,

Sample INTEGUMEMTARY imported,
Sample IY DRIP wMEDS imparted.

To dlose this wizard, click Finish

= Back H Finish

] [ Cancel

Figure 4-6, CP Console Import Wizard Progress Report

8. When the import is complete, click Finish.

i CP Console needs to be restarted now to apply these
changes. Click OK to dose the application.

(o]

Figure 4-7, Close Application Confirmation

9. To apply the changes, you must restart CP Console. To close CP Console, click OK.

After you complete the import and restart CP Console, the views you imported are now available under
the Flowsheet View folder as shown below.

Note: the views you import will be in an “Inactive” status. These views will need to be “Active” before

they are available for use.
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The following figure shows what the imported sample views will look
like:

P Console

File  Tools: Help

1 Search .., = Permissions ... Make Copy ...

=423 Flowsheet View & Item Name: Sample A-LINE
4 Mew CHEST TUBE s
Sample A-LTNE Type: Flowszheet View
Sample BLOOD PROC Access Level: Full Control
Sample CARDIO
Sample CEMTRAL LIK General
Sample: CHEST TUBE Display Mame: Tirme Inkeryval: H-Bis!
Sample DIALVSIS E5E|I'ITI3|E A-LINE | |4 Hours | |DatefTime List |

Sample DRAIN

Sample EMVIRONME! Comment: :
Sample G |Released as part of 4 set of sample visws,

.m Sample GLYCEMIC O -
) i ) -
Sample Gl .. chive " Allaws Pivak

Sample HEMODY AT Terminology

JRi,

Sample IABP Display Mame Farmal Mame

Sample INTAKE L #

Sample INTEGLMENT Girculation Check ARTERIAL LIME CIRCULATION AS. ..
= Size ARTERIAL LIME SIZE

Sample: I¥ DRIP w/MI Condition ARTERIAL LINE COMDITION
Sample Iv FLUIDS Dressing ARTERIAL LIME DRESSING TYPE
Sample Iv SITE Dressing Change ARTERIAL LINE DRESSING CHANGE
Sample MELRC waveform BRTERIAL LINE WAYEFORM

Sample OUTRLIT Alarms on BRTERIAL LINE ALARMS ON

Sample PA CATH

Sample PACEMAKER

Sample PACU

Sample PAIN

sample PRESSURE U
Sample PULM
Sample RESTRAINT o,

soui @

Figure 4-8, Imported Views

4.2. Customizing Flowsheet Views

In order to customize the views for your site, complete the following tasks:
e Make a copy of a sample view
e Rename a copied View
e Edit renamed views

Important: When you are editing a Flowsheet view, you should reload a flowsheet if it has been
edited in the console, or close the flowsheet if it is currently being edited. Otherwise, editing a view
in CP Console can cause other open flowsheets that use that view to show an error.
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Customizing Flowsheets

4.2.1. Making a Copy

Make Copy allows you to copy a flowsheet view. The new view will have a Flowsheets internal ID that
is different from the view that you copied. This is especially useful when you are customizing views that
you have imported.

Note: If you rename an imported view, it does not change the Flowsheets internal 1D and the
renamed view could still be overwritten. If you Make a Copy of a view, it is assigned a new
Flowsheets internal ID and will not be overwritten later by an imported view.

1. Inthe CP Console tree view, select a view. The worksheet for that view appears.

2. On the File menu, click Make Copy or click the Make Copy button. The Confirm Copy pop-up
appears.

Confirm

o B e
\:/ Create a copy of this item?

£ Yes | [ Mo

Figure 4-9, Confirm Copy
3. Click Yes. The copied view appears in the tree view.
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A~ CP Console

File - Tools Help

P Rename < Dot Dlsearch.. @ Permissions .. B Make Copy ...
(3 Flowsheet e Item Name: Copy of Sample A-LINE
{2 Flowsheet Total ;
Flawshest Yiew Type: Flowzheet View
----- rs 5 nple &-LINE Access Level: Full Control
----- &~ New CHEST TUEE
----- & Sample A-LIME General
""" &) Sample BLOOD PRODUCTS T Display Mame: Time Inkerval: ®-fxis:
""" &) Sample CARDIO |Sample: A-LINE | |4 Haurs | |DatefTime List  » |
----- % Sample CEMTRAL LIME ! ot o g
Carnment:

----- &2y Sample CHEST TUBE ! _
_____ % Sample DIALYSIS + |Released as part of a set of sample visws,

----- & Sample DRAIN

) 7 )
----- {2y Sample ENVIRONMENTAL Dlactive Allow Pivot
..... % Sample &1 Terminology
g g:mﬁ:: E::IVCEMIC CONTROL Display Mame | Formal Mame
Circulation Check. ARTERIAL LINE CIRCULATION &5, .,
""" €2 Sample HEMODYHAMICS Size ARTERIAL LINE SIZE
""" £y Sample 1P Condition ARTERIAL LINE COMDITION
----- {2y Sample INTAKE Dressing BRTERIAL LIME DRESSING TYPE
----- % Sample INTEGUMENTARY Dressing Change ARTERIAL LIMNE DRESSIMG CHANGE
..... &b Sample Iv DRIP w/MEDS Wi awveform ARTERIAL LINE 'WAYEFORM
..... {8 Sample Tv FLUIDS Alarms on ARTERIAL LIME ALARMS ON
----- &) Sample Iv SITE -
----- % Sample MEURC o Mo D
----- & Sample QUTPUT
----- & Sample P& CATH

----- & Sample PACEMAKER,
----- & Sample PACU

----- % Sample PAIN v

Figure 4-10, Copied View
4. The view you just created is listed in the tree view with the name of “Copy of” prepended to the
name of the view you copied.

4.2.1.1. Renaming a Copied View

After you copy a view, rename the view you just created. To rename a copied view, complete the
following steps:

1. From the buttons at top of the CP Console menu, click Rename.
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4= CP Console

Flowshest

Flowsheet Tatal

{23 Flowshest Yiew

----- ):4 Copy of Sample &-LIME
..... }_r Copy-of Sample YITALS
----- ' Mew CHEST TUBE

..... &2 Sample A-LIME

----- &y sample CARDID
----- & Sample CEMTRAL LINE

----- &y Sample BLOOD PRODUCTS 1l

- File Tools Help
@F‘E@ . S ) Search .., =d Permissions ... [ Make Copy ...
P C':'ns':'le i Itemy Mame: Copy of Sample VITALS
Background Task :

Type: Flowzheet Yiew

Access Level: Full Control

General

Display Mame:

|Sample VITALS

Coarmnrmenk;

gﬂeleased as part of a set of sample views,

m o

Figure 4-11, Rename Button

2. The Rename Flowsheet window appears.

3. In the New Name field, rename

your flowsheet view.

§ o= mim = m e

&y Samnple DRAIN

Display M F I M
& Sample ENVIRONMENTAL oot s B

Temperature TEMPERATURE
& samplecs 0 — Pulse -
% Sarmple GLYCEMIC COMTROL Resni P

piratary Rate .
£y sample GLI Systolic Blood Pressure Rename Flowsheet View lzl
& Sample HEMODYMAMICS Diastolic Blood Pressure
&) sample 1ABP Mean Blood Pressure Mew Marme:
&2y Sample INTAKE Blaod Pressure (Manual Bl (hew vITALS
L= {

& Sample INTEGUMENTARY gpoz 5°2 Flow Rt
) upp o Rake
& Sample Iv DRIP wiMEDS Fios B [ o ]
& sarnple IV FLUIDS Pain
& sample I SITE Unicht —

& Samnple MELURO

& Sample OUTPUT

4. Click OK.

Figure 4-12, Rename Flowsheet

The renamed Flowsheet View will now appear in the Flowsheet View tree list.
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4.2.1.2. Protecting an Imported or Exported View

The following flow diagram illustrates steps you can follow to protect an imported or exported view.

View Imported

Protect view from
future overwrite?

Copy view

Use the original
imported view
(may be overwritten)

Use the copied view

Existing View
needs to be
changed

Protect changes from
future overwrite?

Copy existing view

Make changes to

first

No

_| Make changes to

the copy

A 4

Use the changed,
existing view

Use the changed,
copied view

the existing (may be overwritten)

ix;ztg;gt;ﬁ :;v Protect view from (OPTIONAL)
ex future overwrite if re- es—p| Copy view Export copy Delete the
ported !
imported? exported copy
Continue to use the
existing view
Continue to use the
N.o Export existing existing view
> view (may be overwritten)
Figure 4-13, Protecting an Imported or Exported View
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4.2.2. Creating a New Flowsheet View
If you choose not to copy a view, you can create your own view using the following steps.

You can create views specific to your site to assemble into your customized flowsheets. You can create an
unlimited number of views. A flowsheet view is comprised of terms, parameters, and qualifiers. You can
assemble one or more flowsheet views into a flowsheet that you use for entering patient data into CP
Flowsheets. A customized flowsheet view allows you to add, edit, and remove terms, as well as change
the display order of the terms.

To create a flowsheet view:

1. From the File menu, highlight New and select Flowsheet View. The Create New Flowsheet View
pop-up appears.

@

Create New Flowsheet View @

[ OK ][ Cancel J

Figure 4-14, Create New Flowsheet View

2. Inthe Name box, type a name for the new view. The name appears in the tree view and as the ltem
Name at the top of the CP Console main window.

3. Click OK. The new Flowsheet View worksheet appears.

General
Display Mame: _ Time Interval: X-Axis:
New Flowsheet Yiew 24 Hours v | | Terminology List
Comment:
MNew View
[Cactive [[] allow Pivot
Terminology
+ add...
S Edt ...

Figure 4-15 Flowsheet View Worksheet

38 Clinical Procedures (CP) Flowsheets Module V1.0 August 2011
Implementation Guide



L N o g &

The name you just added appears in the Display Name box.
From the Time Interval list, select a time interval to display across the y-axis (columns).
From the X-Axis list, select a list, Terminology or Date/Time, to display across the x-axis (rows).
Optional: In the Comment box, type additional information about the view.
To make the view available in CP Flowsheets, select the Active check box.

To be able to switch axes, the intervals (columns) with the lists (rows), select the Allow Pivot check
box.

Click Save to save your new Flowsheet View.

Flowsheet View Definitions

The following are definitions specific to Flowsheet Views:

Display Name: Display Name describes the flowsheet view with a unigue name, so you can identify it in

the list of flowsheet views.

Time Interval: Time Interval sets the default time interval for the view display when accessed through

CP Flowsheets. Choices range from one minute to 24 hours.

X-AXxis: X-Axis sets the column headers along the top of a view to Date/Time or Terminology selections.

Y-axis represents data type (rows) along the left side of a view.

Comment: Optional — You can provide additional information regarding the flowsheet view.

Active: The flowsheet view is active and available in CP Flowsheets.

e Select the Active check box to make the flowsheet view active and available.
e Clear the Active check box to inactivate the flowsheet view.

Note: If the Active check box is not selected, the view does not load and you cannot enter data.
A pop-up appears to indicate that the view is not active. The inactive view may display in the
report.

In the tree view, an active view appears with -
Copy of Sample A-LINE
4~ Mew CHEST TUBE
- Mew YITALS

@L o~ [

Figure 4-16 - Active View

Allow Pivot: Allow Pivot switches the x-axis (column) selection to present along the y-axis (row) of a

view. You can make the switch while using the flowsheet.
Select and clear the check box to change the default view of the flowsheet view.
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4.2.3. View Terminology Editor

Display Name: You assign a name to the view that appears in CP Flowsheets on your flowsheet.

Use the View Terminology Editor window to add terms (click Add) and to modify existing terms (click

Edit).

r;’ View Terminology Editor Q@@

Term

Term:
I
-‘} [use Dropdown

Term Display Properties:

F [[]input required for this term
[ pisplay Min ¥alue Row
[ pisplay Max value Row

Qualifiers

[ OK ” Cancel ]

Figure 4-17, View Terminology Editor

4.2.4. Adding Terms to a View

Use the View Terminology Editor window to add terms to a view. To add terms to a view:

1. Click on the view you would like to modify.

2. Click . The View Terminology Editor window appears.
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rﬁ View Terminology Editor Q@@

Term

Term:

I

[[Juse bropdown

Term Display Properties:

[CJ1nput required for this term
[ pisplay Min Value Row
[ pisplay Max Yalue Row

Qualifiers

[ OK ][ Cancel ]

Figure 4-18, View Terminology Editor
From the Term drop-down list, select a term.

Note: The Term list contains terms provided with CP Console. You cannot add terms to the CP
Console list. If you need to request or modify a term, refer to the following site for Terminology
information:

http://vista.med.va.gov/clinicalspecialties/clinproc/newTerm.asp

To set the default unit of measurement, if the selected term requires a default unit, select a unit from
the Default Unit drop-down list.

For Example:
Body temperature is always entered in degrees Fahrenheit. Select Degrees F from the drop-down list.
The end user does not need to select Degrees F every time they enter a temperature.

Optional: Change the display name.
The Display Name automatically populates when you select a term.

To set a display width, select a width (in number of characters) from the Display Width drop-down
list.

To set the display columns, if the selected term requires columns, select the number of columns to
display from the Display Columns drop-down list.

Select the Use Dropdown check box to display the selections in a flowsheet in a drop-down list
rather than as radio buttons.

From the Term Display Properties box, select one or more check boxes to provide calculations
automatically in the view:

e Display Totals Row
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e Display Average Row

e Display Count Row

e Display Min Value Row

e Display Max Value Row

e Display Subtotals by Time Interval
e Display Row as Read Only

e Input required for this term

Refer to the following section, Term Definitions for further detail on the above terms.

10. If the term you select has qualifiers associated with it, you need to make additional selections. Not all
terms have qualifiers.

a. Select one or more check boxes of the available qualifiers.
b. Select descriptors for the qualifiers from the respective drop-down lists.
c. Select the appropriate Mandatory check boxes to make qualifiers required fields.

For Example:

Weight has three qualifiers available: Method, Location, and/or Position. Define a method for taking
the weight, by selecting a descriptor.

11. Click OK.
12. Click Save.

13. To add additional terms to a view, repeat steps 1-11.

4.2.4.1. Term Definitions

The Term section allows you to customize the term parameters and associated qualifiers.
Term: Term is the approved, standardized wording used for the observed clinical procedure/activity.
Default Unit: Default Unit is the unit of measure at which to set the default.

You must select a default unit for a numeric unit.

Example
Body temperature is always entered in degrees Fahrenheit. Select Degrees F from the drop-down
list. Then you do not need to select Degrees F every time you enter a temperature.

Display Name: Display Name describes the selected term with a unique name, so you can identify it in
the list of terms.

Display Width: Display Width is the maximum number of characters used in the field.
Display Columns: Display Columns is the number of columns to display in the view.

Use Dropdown: Use Dropdown allows you to display selections in a flowsheet in a drop-down list rather
than a radio button options.

Display Only: Display Only prevents you from manually adding data for the observations.
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Term Display Properties: You can select one or more properties for the selected term to provide
calculations automatically for display in the view.
¢ Display Totals Row—provides a totals row for observations for display in the view
e Display Average Row—provides an average row for the observations for display in the view
e Display Count Row—provides a count row for the observations (the number of results in a
particular column) for display in the view
e Display Min Value Row-provides a minimum value row, a row of the lowest number of
observations
e Display Max Value Row—provides a maximum value row, a row of the highest number of
observations
e Display Subtotals by Time Interval-provides subtotals by time intervals (calculations
automatically by time intervals) for the observations for display in the view
¢ Display Row as Read Only-allows a row to be labeled read only for display in the view
¢ Input required for this term-indicates whether the term must have observations recorded

4.2.5. Working with Qualifiers

A qualifier is an additional choice you can add to a term, such as the examples below. Not all terms have
qualifiers. A term can have several qualifiers as specified in the terminology list. Those that display
depend on the term you select. If the term you select has qualifiers associated with it, you can make
additional selections.
Identify the type of qualifier by selecting the associated check box, such as:

e  Method-lift scale, monitor

e Quality—actual, estimated

e Location—L arm, right upper lobe

e Position-sitting, standing

e Product—platelets, 5 percent albumin

Indicate that a qualifier is a required field by selecting a Mandatory check box.
If a qualifier is set to Mandatory, you cannot clear the qualifier from the flowsheet view data entry form.
Note: You can clear the qualifiers that are not mandatory with the ESC key.

Select a descriptor for the type of qualifier from the respective drop-down list.
¢ When you do not select a qualifier, no default appears in the qualifier drop-down.
¢ When you select a qualifier, it appears in the drop-down as an editable default.

¢ When you select a qualifier and select mandatory, the qualifier appears in the drop-down and you
cannot change it.

For Example:

Systolic Pressure has three qualifiers available: Method, Quality, and/or Position. Define a method for
reading systolic pressure by selecting one or more of the qualifiers with associated parameters.
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For information on creating a flowsheet view, refer to the Creating a Flowsheet View section in Chapter

4.

4.2.6. Changing the Display Order of Terms in a View

Use Move Up and Move Down to change the display order of the terms in a view. To change the display

order of terms in a view:

1. Highlight the term you want to move in the display order of the view.

. Move U . . ) Move D
2. Cllckto move the term up in the display order or click e oo to move the

term down in the display order.
3. Click Save.

4.2.7. Modifying Terms in a View

Use the View Terminology Editor window to modify the term qualifiers and associated descriptors of the
terms of newly created views, as well as existing views. To edit terms in a view:

1. Highlight a term from the Terminology list.

General
Display Mame: _ Time Interval: X-Axis:
cb Yiew 24 Hours V| | Terminology List %
Comment:
New Yiew
Active Allow Pivot
Terminology
Temgerature TEMPERATURE » 4 Move Up
Input INPUT F acd
S Edt ...

Figure 4-19, Terminology List

. Edit ... . . . .
2. Click . The View Terminology Editor window appears.
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42 Yiew Terminology Editor, |:||E|rz|

Term
Term: Default Unit:
T | o vl
Display Manne: Display Width:  Display Calumns:
|Weight | 5120 |= e Use Dropdown
Term Display Properties:
[pisplay Totals Row [ Display Subtatals By Tirme Interval
[Display Average Row [ Display Rove &s Read Only
[ oisplay Count Fow [ tnput required for this term

[ Display Min Yalue Row
[ oisplay Max ¥alue Row

Qualifiers
Method iSTANDING WEIGHT v | [EIMandatary
Quality |AcTUAL vl Mandatary
Position iSTANDING ¥ | [Zlmandatory

[ o [ coed |

Figure 4-20, View Terminology Editor
Change any or all of the parameters in the Term section.
If the term has qualifiers, change any or all of the qualifiers/descriptors in the Qualifiers section.
Click OK.
Click Save.
To edit additional terms in existing views, repeat steps 1-6.

N o gk~ w
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4.2.8. Removing Terms from a View
Use Remove to delete terms from a newly created or existing view. To remove terms from a view:

1. From the Terminology list, highlight a term.

General
Display Name: Time Interval:  X-fixis:
;ch View 24 Hours ¥ || Terminology List v ‘
Comment:
‘New View ‘
Active Allow Pivot
Terminology
Temperature TEMPERATURE | [ 4 Moveup
w.w
|Inpu INPUT | F acd
S Edt ...

Figure 4-21, Terminology List

. - R .
2. Click . Confirm pop-up appears.

¢ , Remove the term "Weight' from this view defintion?

2

Figure 4-22, Confirm Pop-up
3. Click Yes.

4. Click Save.
5. To remove additional terms from a view, repeat steps 1-4.
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5. Creating Flowsheets in CP Console

CP Console allows you to create flowsheet views and flowsheet totals, which you assemble into your
individualized flowsheets to meet your site-specific requirements. Although the order in which you create
the parts of a Flowsheet is not critical (you may use some sample flowsheet views and totals supplied
with Flowsheets), you must have the following components to create a Flowsheet.

e Flowsheet view(s), including sample flowsheet views supplied with Flowsheets, that contain the
information you want to include on your Flowsheet. Before publishing a Flowsheet, you must
find or create the flowsheet views you wish to include on your Flowsheet.

e Flowsheet total(s) including sample flowsheet totals supplied with Flowsheets, that contain the
information you want to include on your Flowsheet. Before publishing a Flowsheet, you must
find or create the flowsheet totals you wish to include on your Flowsheet.

To create a Flowsheet in CP Console, complete the following steps:
1. From the File menu, highlight New and select Flowsheet. The Create New Flowsheet pop-up

appears.
Create New Flowsheet @

Name:

[ OK J[ Cancel

Figure 5-1, Create New Flowsheet

2. Inthe Name box, type a descriptive name for the new flowsheet, for example ICU_VITALS or
NHCU_VITALS. The name appears in the tree view and as the Item Name at the top of the CP
Console main window.

3. Click OK. The new Flowsheet worksheet appears.
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General

Display Mame:

Mew Flowsheet [ active
Comment: TIU Mote Title for reporting:
Comment b
Pages Totals
View (Type) Display Name

Figure 5-2, New Flowsheet Worksheet

Note: Not all users have permissions to create or edit Flowsheets. Refer to the Permissions
section for more information.

5.1. Adding a new Flowsheet

To add a new flowsheet:
1. Inthe Display Name box, type a name for the new flowsheet.
2. To make the flowsheet available in CP Flowsheets, select the Active check box.

3. Optional: In the Comment box, type additional information about the flowsheet.

Note: This comment is only visible in CP Console.
4. Make sure an appropriate TIU title exists and is active in CPRS.
5. From the TIU Note Title for reporting list, select a note title to display in CPRS.

Note: Selection is most accurately done by copying the TIU note title from CPRS or Vista or paste the
title onto a text page, for example, Notepad or MSWord. Copy and paste the title name into the General
section - "T1U note title for reporting".

You have the option to QUICKLY type the first 3-4 characters of the TIU note title. However, if you have
several note titles that start out with the same 3-4 characters such as NURS, this could cause your system
to lock up. Therefore, it is recommended that you copy and paste note contents.

6. Click Add. The New Flowsheet Page window appears.
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5.1.1. Adding a View to a Flowsheet

Use the New Flowsheet Page window to add a view to a new or existing flowsheet. To add a view to an
existing flowsheet:

1. Select the Pages tab and click . The New Flowsheet Page window appears.

#2'New Flowsheet Page g@@
Wigna Page Tvpe:
w | | (®mMandatory
() optional

Display Name:
() supplemental

Cancel

Figure 5-3, New Flowsheet Page

2. Select a view from the View drop-down list.

Note: The View list contains the flowsheet views you created under Flowsheet View in CP
Console, along with any default flowsheet views created by the development team.

3. The Display Name automatically populates when you select a view. If you change the display name,
the view name changes in CP Console, and appears as Page Name in a new session of CP Flowsheets.

4. Select a type from the Page Type options: Mandatory, Optional, or Supplemental (defined below)
e Mandatory — mandatory views cannot be closed

e Optional — the optional view is not always displayed. Optional views can be added one at a
time (for example, ventilator or pacemaker) and can be turned on or off as necessary and
continue to be used with no loss of data.

Note: An optional view is configured to document assessments related to singular non-invasive device
types where documentation flow is suitable to follow on a continuum with the original entry.

The optional view is added for initial documentation for a number of hours/days. The view can be closed
after the device is discontinued. If the device is later placed back into use, adding the optional view again
re-activates the original view for continuing documentation.

If you are tracking usage of model numbers, lot numbers, or invasive lines, then configure device
assessments in a supplemental view.

e Supplemental — you can use the view, but it is not necessary for all flowsheets; a
supplemental view does not display initially, you have to add it to the flowsheet. You can use
multiple supplemental views (for example IV bags or multiple wounds). If you close a
supplemental view and add a new one, the new one will be blank. The data is locked into that
view. The closed supplemental view can still be viewed on the flowsheet and report.

5. Click OK.
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6. Click Save.
7. To add additional views to a flowsheet, repeat steps 1-6.

Note: There are no restrictions to the number of times a view can be added to a flowsheet.

5.1.2. Pages Tab

Use the Pages tab to add, edit, or remove a view, as well as arrange the display order of the views on a
flowsheet.

Pages Totals
Page Name View (Type)
cb Yiew cb view {Mandatory)
cb Yiew 1 cb View 1 (Mandatory)
Figure 5-4, Pages Tab
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5.1.3. Editing a View Type in a Flowsheet

Use the Edit Flowsheet Page window to change a view type in a new or existing flowsheet. To edit a view

in a flowsheet:
1. Select the Pages tab, highlight a view.

Pages  Totals |
Page Name View (Type)
cb View cb view {Mandator:
cb View 1 cb Yiew 1 {Mandator L &
+ add...
S Edt ...

Figure 5-5, Pages Tab

From the View drop-down list, select a view to modify.
Optional: Change the display name.

Click OK.
Click Save.
To edit the page types of additional views, repeat steps 1-7.

© N o g bk~ DN

. Edit ... . .
Click . The Edit Flowsheet Page window appears.
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5.1.4. Removing a View from a Flowsheet

You can use Remove to delete a view from a flowsheet. To remove a view from a flowsheet, complete
the following steps:

1. Select the Pages tab. Highlight the view to delete.

Pages  Totals |
| Page Mame View__(Type) -
[ cb view cb view {Mandator:
b View 1 cb Yiew 1 {Mandator L &
+ add...
S Edt ...

Figure 5-6, Highlight View to Delete

>, click L=Remore ]

3. Click Save.

5.1.5. Changing the Display Order of Views in a Flowsheet

Use Move Up and Move Down to change the display order of the views in a flowsheet. To change the
display order of views in a flowsheet, complete the following steps:

1. Highlight the view you want to move in the display order of a flowsheet.

Pages Totals
PageNama View (Type)
| cb View 1 cb View 1 (Mandator [
{Respirator RESPIRATORY (Mandator: | [M]
| cb View cb view {Mandatory)
Figure 5-7, Highlight View to Move
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2. Cllckto move the view up in the display order or click Az to move the

view down in the display order.
3. Click Save.

5.2. Creating a Flowsheet Total
The flowsheet total allows you to display the sum of numeric observations within that flowsheet view.

Note: Totals are based on active date ranges from the displayed flowsheet. The calculation of the totals
can include observations which may not be on the displayed flowsheet.

The following screen illustrates the active date ranges from the displayed flowsheet:

& CP Flowsheets

File “iew OCbservation Period Flowsheet Help
CPPATIENT. EIGHT - F [Age: 32)
D alarm{z] active
Date Of Birth: Aug 8, 1978 SSN: (0008)
Ward: 1A Room-Bed: 102-1
£3) Open Patigfit . 2010-12-16 00:00 to 20101216 2363 =
| B Flowshest Y tend Date Back 1 Day onitor
i M Pan Date Back 1 Day
Flowsheet: = Set Date Range ... esh [Y AddPage.. #X ClossPage...  View: [#|verified []Corrected []Synchronize
M Pan Date Forward 1 Day
El Test Flowsheet 3 -
=+ Eutend Date Forward 1 Day = < % = Display Inkerval: |24 Hours w
Aadd Data .. Scroll Scroll Settings
Today (00:00-23:59)
I ]
Dec-16-10 Do:00 - 23:59 I
E sLC ICU CARDIO TEST ] 3
= ﬁl < ; J‘* Display Inkerval: |2 Hours w
Add Data ... Pivot Scroll Scroll Settings
Heart Rate Cardiac Rhythm | Heart Sounds Edema - Generalizec‘ Edema - R Leg
Dec-16-10 00:00 - 01:59
02:00 - 03:59
04:00 - 05:59
06:00 - 07:59
08:00 - 09:59
10:00 - 11:59
12:00 - 13:59
14:00 - 15:59
16:00 - 17:59
18:00 - 19:59
20:00 - 21:59
22:00 - 23:59 o

Figure 5-8, Active Date Ranges

Additional configuration approaches are addressed in supplemental documentation.
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Creating flowsheet totals involves adding and removing terms, as well as changing the display order of
the terms.

General

Display Name . Default Unit _ Decimals
(cb total | [urars Je =

Comment
[New Flowsheet Total Definition ‘ Active

Display Properties:

Display Total (All Terms) Display Maximum
Display Count {all Terms) Disy rm
Display Average (all Terms)

Display Minimum
Terminology
Available Terms Selected Terms
| ABDOMEN ~ ‘ ‘iWOUND INCISION DRESSING
ABDOMEN BOWEL SOUNDS =) | WOUND DRAINAGE AMOUNT
ABDOMINAL GIRTH [ | TEMPERATURE
ACTIVITIES OF DAILY LIVING | SYSTOLIC PRESSURE
AFFECT |SETzURES
ALARM PARAMETERS YERIFIED | PUPIL REACTION
ALARMS > 4PERCENT MEAL CONSUMED

Figure 5-9, Create a Flowsheet Total

Flowsheet Totals
'I'nI.nIl Count Aueragel Mhimuml Ma:dmuml

Intake PO Fluids 800,00 (mi) 3 56.67 (mi) 200.00 {mi) 360.00 {mi)
Intake - IV Fluids 725.00 (i) 3 241.67 (ml) 100.00 {mi) S00.00 {mi)
Intake - IV Meds 350,00 (mi) 4 §7.50 (m) 50.00 (mi) 150.00 (i)
Intake - EF Tube 2500 (mi) 1 25.00 (mi) 25.00 {mi) 25.00 {mi)

- Total 1900.00 {ml) 11 172.73 (mi)
Urine Output 360,00 (wi) 1 350,00 (mi) 360.00 (mi) 360,00 (i)
GI Tube Qutput 0.00 {mif) 0 i e s
Stool Dutput 0,00 (mi) 0 _— — —
Chest Tube Dramage Volume [m 0.00 (mi) 0 — = -

- Total | 360,00 {mi) 1 360,00 (i)

Figure 5-10, Totals Display from CP Flowsheets

To create a flowsheet total:

1. From the File menu, highlight New and select New Flowsheet Total. The Create a New Flowsheet
Total pop-up appears.
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Create New Flowsheet Total

MName:

[ OK ][ Cancel ]

Figure 5-11, Create a New Flowsheet Total

2. In the Name box, type a name for the new total. The name appears in the tree view and as the ltem
Name at the top of the CP Console main window.

3. Click OK. The new Flowsheet Total worksheet appears.

5.2.1. Editing the Flowsheet Total

1. Inthe Display Name box, type a name for the new total.
2. To set the default unit, select a unit from the Default Unit drop-down list.

3. From the Decimals box, select the number of decimals for the default unit, 0-8.
Default is 2.

4. Optional: In the Comment box, type additional information about the flowsheet total.
To make the total available in CP Flowsheets, select the Active check box.

6. From the Display Properties box, select one or more check boxes to provide calculations
automatically on the view:

e Display Total (All Terms)

e Display Count (All Terms)

e Display Average (All Terms)
e Display Minimum

e Display Maximum

5.2.1.1. Terminology Section

1. To move aterm from the Available Terms list, select the term and click to move it into the

Selected Terms list.

2. To move a term from the Selected Terms list, select the term and click to move it into the
Available Terms list.
3. Repeat steps 1 and 2 as many times as is necessary.
(4]
t

4. To arrange the list of Selected Terms in a specific display order, select a term and click 0

move the term up the display order or @ to move the term down the display order.

5. Repeat step 4 until you have the list in specific display order.
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6. Click Save.

5.2.2. Totals Tab

From the Flowsheets tree, select the Totals tab to add totals to and remove totals from a flowsheet, as well
as, change the display order of totals on a flowsheet.

Pages Totals
Available Totals (Active Only) Assigned Totals in Order of Display
cb total cb total
cbtotal 1 cb total 1

Figure 5-12, Totals Tab

5.2.2.1. Adding Totals to a Flowsheet

To add a total to a flowsheet:
1. Onthe Totals tab, highlight the total in the Available Totals list you want to add.

2. Click @

3. Click Save.

. The total moves to the Assigned Totals list.
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5.2.2.2. Removing Totals from a Flowsheet

You can use the left arrow to remove a total from a flowsheet. To remove a total from a flowsheet:
1. On the Totals tab, highlight the total in the Assigned Totals list you want to remove.

2. Click . The total returns to the Available Totals list.
3. Click Save.

5.2.2.3. Changing the Display Order of Totals in a Flowsheet

Use the up arrow and the down arrow to change the display order of the totals in a flowsheet. To change
the display order of the totals:

1. Highlight the total you want to move in the display order of a flowsheet.

N . : . :
2. Click D to move the total up in the display order or click @ to move the total down in the
display order.

3. Click Save.

5.3. Flowsheet Total

The flowsheet total allows you to display the sum of all observations of a single type within that
flowsheet view. Totals use date ranges from the primary flowsheet form as ranges for the totals. The
calculation of the totals uses all the intakes (observations) for a specified date/time range, which includes
those that display on the flowsheet, as well as the intakes that do not.

1. From the File menu, highlight New and select Flowsheet Total. The Create New Flowsheet Total
popup appears.

[ o

Create Mew Flowsheet Total

Marme:

[ Ok H Cancel ]

Figure 5-13, Create New Flowsheet Total

2. In the Name box, type a name for the new Flowsheet Total and click OK
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3. The new Flowsheet Total worksheet appears.

General

Display Name Default Unit chimals
cb total UNITS v 2 =
Comment

Mew Flowsheet Total Definition Active

Display Properties:

Display Total {(All Terms) Display Maximum
Display Count (all Terms) il

Display Average (Al Terms)

Display Minimum
Terminology
Available Terms Selected Terms
ABDOMEN A WOUND INCISION DRESSING
ABDOMEN BOWEL SOUNDS WOUND DRAINAGE AMOUNT
ABDOMINAL GIRTH = | TEMPERATURE
ACTIVITIES OF DAILY LIVING | SYSTOLIC PRESSURE
AFFECT | SEIZURES
ALARM PARAMETERS VERIFIED PUPIL REACTION
ALARMS v PERCENT MEAL CONSUMED

Figure 5-14, Build a Flowsheet Total

5.3.1. Understanding Totals Display

Display Name: Display Name describes the flowsheet total; it appears as the title of the report.
Default Unit: Unit of measure that the flowsheet total uses as a default.

Decimals: Number of decimal places for the unit, 0-8; default is 2.

Comment: Optional — You can provide additional information regarding the flowsheet total.
Active: The flowsheet total is active and available in CP Flowsheets.

e Select the Active check box to make the flowsheet total active and available.
e Clear the Active check box to inactivate the flowsheet total.

Note: If the Active check box is not selected, the flowsheet total does not load and you cannot

enter data. A pop-up appears to indicate that the flowsheet total is not active. The inactive
flowsheet total may display in the report.

In the tree view, an active flowsheet total appears = .

FLOWSHEET Ratio
2 FLOWSHEET TOTAL
MEW FLOWSHEET TOTAL

Figure 5-15, Active Flowsheet
Display Properties: Select one or more properties to display on your flowsheet.
e Display Total (All Terms)—-sum of all observation amounts
o Display Count (All Terms)-number of results of an observation within a flowsheet view
o Display Average (All Terms)—average of all observations
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e Display Minimum-lowest number of observations
e Display Maximum-highest number of observations
e Display Ratio (Term 1/Term 2)

e Display Difference (Term 1-Term 2)

5.4. Setting up Default Shifts

Flowsheets allows you to set up standard default shifts for your site and departments.

Additional configuration approaches are documented in supplemental documentation.

5.4.1.1. Shift Information Definitions

The following are definitions for Shift Information in CP Console:

Display Name: Display Name describes the shift with a unique name, so you can identify it in the list of
shifts.

Active: The shift is active and available in CP Flowsheets.
e Select the Active check box to make the shift active and available.
e Clear the Active check box to inactivate the shift.

Note: If the Active check box is not selected, you cannot use the shift in your flowsheets.
In the tree view, an active shift appears '@.

¢ DAYS -3
¥ Holiday

&3 EVENINGS

Figure 5-16, Active Shift
Comment: Optional - You can provide additional information regarding the shift.
Start Time: 12:00 AM through 11:45 PM in 15-minute increments.
Stop Time: 12:00 AM through 11:45 PM in 15-minute increments.

5.4.1.2. Adding a Shift

Use the Shift Information worksheet to create your shifts. To add a shift:
1. From the File menu, highlight New and select Shift. The Create New Shift pop-up appears.

Figure 5-17, Create New Shift

2. In the Name box, type a name for the new shift. The name appears in the tree view and as the ltem
Name at the top of the CP Console main window.
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3. Click OK. The new Shift worksheet appears.

Shift Information

Display Name:

New Shift [ active
Comment:

Mew Shift Definition

Start Time: Stop Time:

08:00AM v | |04:30PM v

Figure 5-18, Shift Worksheet
In the Display Name box, type a name for the new shift.
To make the shift available in CP Flowsheets, select the Active check box.
Optional: In the Comment box, type additional information about the shift.
From the Start Time drop-down list, select a begin time.
From the Stop Time drop-down list, select an end time.
Click Save.

© © N o a &~

5.4.1.3. Modifying an Existing Shift

Use start and stop times to modify your shifts. To modify an existing shift:
1. From the CP Console tree view, highlight Shift and expand the folder.

2. Select a shift from the list. In the following figure, the “Days-2" shift is selected.
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# CP Console

File Tools Help
¢ #Rename X Delste ... Z Search... =@ Parmissions ...
= {23 CP Console Item Name: DAYS - 2
(23 Background Task Type: Shift
(Z3 Flowsheet p——
(22 Flowshest Total Access Leveull Lonltro
(3 Flowshest View Shift Information
g ;nsu.umgt Displary Mame:
arameters - N
Early Dav Shift Active
(23 Procedure | | 9
(3 Schedule Comment:
=423 Shift |neno-1430 |
e, 2 .
i BellTestShift Start Time: Stop Time:
$ Davs - 1 [os:00am v [ozzarm
& EEE
& DaYS - 3
& DK Shift
& EVEMINGS

& MIDNIGHTS
&5 WEEKEMD - DAYS
& WEEKEND - MIGHTS

Figure 5-19, Selected Shift
3. Make the necessary changes to one or more fields of the shift worksheet.
4. Click Save.
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6. Additional Flowsheet Tasks

6.1. Setting up Background Tasks

CP Console background tasks are system activities (which run in the background) that you can schedule.
The three available cleanups address CliO, CP Legacy, and the HL7 Cleanup. These settings are
determined according to site policy.

===} CF Console

=3 Background Task

Cli0 Cleanup
CP Cleanup
HL7 Cleanup

[C] Flowsheet

[C] Flowsheet Total
[[] Flowsheet View
(2 Instrument

[C] Parameters
(L) Procedure

(2] Schedule

] shift

Figure 6-1, Background Tasks

Select one of the background tasks and its properties appear.

Item Name: Cli0 Cleanup
Type: Background Task

Access Level: Full Control

Background Task
Task ID: I |
Name: I |
Status: | |
Scheduled: | |

Figure 6-2, CliO Cleanup Background Task Properties
e Task ID: The identifier assigned to the task.
e Name: The name of the background task.
e Status: The status of a background task can be Active: Pending or Active: Running.

e Scheduled: Scheduled indicates the date and time the background task begins; the Default is Not
Scheduled.
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6.1.1. CliO Cleanup

CliO is a database that stores patient observations. You can store data in a variety of formats. Old
observations that are not in a state of verified or corrected are purged.

Note: If student/trainee documentation is not in a state of verified or corrected, it will also be purged.

To change the scheduling of Clio Cleanup:

1. Under Background Task, click CliO Cleanup.

2. Click Change.

3. Schedule the task. Refer to the Changing the Schedule for a Task section for more details.

6.1.2. CP Cleanup

CP Cleanup background task cleans up observations (unencoded or XML data) from instruments
(monitors) that are not in a verified state (data that is not clinically relevant). This cleanup is designed to
run after data is processed, and deletes the data that is not clinically relevant from both Legacy and CliO.
It runs through the UPLOAD ITEM field in the CP RESULT REPORT file (#703.1) and purges
unnecessary data from previous uploads.

To change the scheduling of CP Cleanup:

1. Under Background Task, select CP Cleanup.

2. Click Change.

3. Schedule the task. Refer to Changing the Schedule for a Task for more details.

6.1.3. HL7 Cleanup

The HL7 Cleanup purges messages not validated that remain more than a number of days set by you, in
the HL7 log file.

To change the scheduling of HL7 Cleanup:
1. Click HL7 Cleanup.
2. Click Change.

Schedule the task. Refer to the Changing the Schedule for a Task section for more details.
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6.2. Adding an Instrument

Use the new instrument worksheet to add new instruments to Clinical Flowsheets. To add an instrument,
complete the following steps:

Note: The instrument worksheet is for legacy CP instrument connections only. For MD*1.0*16
connections, all information required will be exported as part of a centrally maintained mapping file.

1. From the File menu, highlight New and select Instrument. The Create New Instrument pop-up
appears.

r

Create New Instrument @

MName:

[ OK ][ Cancel J

Figure 6-3, Create New Instrument

2. In the Name box, type a name for the new instrument. The name appears in the tree view and as the
Item Name at the top of the CP Console main window.

3. Click OK. The new Instrument worksheet appears.

General

Comment: Print Name:
New Instrument Active
Serial Number: Motification Mailgroup:
v
Attachment Processing
Default Ext.: M Routine: Pkg Code: Valid Attachment Types:
v | [JUUEncode Cune
L [CDrext
[T]pelete when submitted [Jxms [Jure
[Clow

Bi-Directional Capabilities

D Bi-Directional Instrument
1P Address: Port: HL7 Inst ID: HL7 Unv Svc ID: HL7 Link:

Figure 6-4, New Instrument Worksheet

4. Optional — In the Comment box, type additional information pertaining to the instrument.
5. Inthe Print Name box, type the name as you want it to appear on the instrument report.
6. To make the instrument available in CP Flowsheets, select the Active check box.
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7. Inthe Serial Number box, type the serial number of the instrument.

8. From the Notification Mailgroup drop-down list, select a local VistA mailgroup.
Click in the box and type an alpha character, such as b, p, or r, at which you want the list of
mailgroups to begin.

6.2.1. Modifying an Existing Instrument

Use the Instrument worksheet to modify the parameters of an existing instrument. To modify an existing
instrument, complete the following steps:

1. Inthe tree view, highlight Instrument and expand the folder.
2. Select an instrument from the list.

In the following example, the Aware instrument is selected.

# CP Console

File Tools Help

- & Rename S Search ... =8 Permissions ...
= & g CD”EDE ek 2 Item Name: AWARE

+ Background Tasl
Type: Instrument

+-[7] Flowshest yp e

(1] Flowsheet Taotal Access Leverul Lontio

-1 Flowshest Wiew General

T az:;mentH i Cormment: Print Marme:

-_ en YREFENSION GE AWARE Gateway GE AWARE Gateway Active
. Setial Mumber: Matification Mailgroup:

AWARE
AXIOM Sensis
AXIOM Sensis (Bi-Directional)

Attachment Processing

AXIOM Sersis (Diag. Cor. Cath) Default Ext,: M Routine: Pkg Code: Yalid Attachment Types:
AXIOM Sensis (EP Studhy) v E;’-’qf”“de E#’Q’i
AXIOM Sensis (Ped, Card, Int.) [belste when submitted (s CJURL
AXIOM Sensis (Ped. Car, Cath) FiEte when shmite Clow
BRAUN
BRAUN (Bi-Directional) Bi-Directional Capabilities
CATHCOR DBi—Directional Instrument
CATHCOR (Bi-Directional) IP Adddrese: Part: HL7 Inst ID: HL7 L7k
) cB-MORTARA AARE Z
CB-MORTARS (EKG)
CB-MORTARA (Halter)
CB-MORTARA (Stress)
Figure 6-5, Selected Instrument
3. Make the necessary changes to the fields of the instrument worksheet.
4. Click Save.
Comment: Optional — You can provide additional information regarding the instrument.
Print Name: Name of the instrument to print on the instrument report.
Active: The instrument is active and available in CP Flowsheets.
e Select the Active check box to make the instrument active and available to transmit results.
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e Clear the Active check box to prevent the instrument from transmitting results.

Note: If the Active check box is not selected, you cannot use the instrument in your flowsheets.
In the tree view, an active instrument appears -~ 8

Muse Pacemaker EKG
NEW INSTRUMENT
MEW INSTRUMENT (1)

Figure 6-6, Active Instrument
Serial Number: Serial number of the instrument is assigned by the manufacturer.

Notification Mailgroup: Identify a local VistA mailgroup to notify when a problem arises with an active
instrument.

6.2.2. Attachment Processing
Complete the following steps to select and process an attachment:
1. Inthe Default Ext box, type the default file extension exported by the vendor.
2. Inthe M Routine box, type the routine the instrument uses to process HL7 messages.
3. From the Pkg Code drop-down list, select the code of the processing package.
4

Select the Delete when submitted check box if the site does not store a duplicate report
or the vendor deletes reports because of storage issues.

5. From the Valid Attachment Types options, select one or more method of attaching
patient data.

The following are Attachment Processing definitions:
Default Ext: Default file extension exported by the vendor (.html, .pdf, .jpg).
M Routine: MUMPS routine used to process the HL7 message from the active instrument.

Pkg Code: Code of the package that processes the active instrument results.
e Medicine — Medicine package
e CP V1.0 - Clinical Procedures v1.0
e CIliO — Clinical Observation database

Delete when submitted: Select the check box if the site does not want to store a duplicate report outside
of Imaging or the vendor wants to delete files because of storage issues.

Valid Attachment Types: The type of patient data expected from the instrument. Data type indicates to

CP Console the kind of data output to expect from the instrument.

e UUENcode (Unix to Unix Encode)-a set of algorithms for converting files into a set of
ASCII characters to transmit over a network

e XML (Extensible Markup Language)—a specification for Web documents developed by the
World Wide Web Consortium (W3C), the organization that sets standards for the Web; XML
is a pared-down version of Standard Generalized Markup Language (SGML)

e XMS-XML Style Sheet

e DLL (Dynamic Link Library)-a library of executable functions or data used by Windows
applications

August 2011 Clinical Procedures (CP) Flowsheets Module V1.0 69
Implementation Guide



Additional Flowsheet Tasks

e UNC (Universal/Uniform Naming Convention)-a personal computer (PC) format for
specifying the location of resources on a local-area network (LAN)
e Text-Text stored as ASCII codes

e URL (Uniform Resource Locator)-the global address of documents and other resources on
the World Wide Web (www)

6.2.3. Adding a Configuration for a Bi-Directional Instrument
To add a configuration for a bi-directional instrument, complete the following steps:

1. If the instrument is bi-directional, select the Bi-Directional Instrument check box.

d. Type inthe IP Address assigned to the instrument, the Port (location) assigned to the instrument,
the HL7 Instrument ID for the instrument, and the HL7 UNV SRV ID for the instrument
procedure.

e. From the HL7 Link drop-down list, select the unique link for the instrument.
Click in the box and type an alpha character, such as b, p, or r, where you want the list of
instrument links to begin.

Note: This area of the screen is for informational purposes only.
2. Click Save.

The following are term definitions for bi-directional instruments:
Bi-Directional Instrument: An instrument that both sends and receives data.

IP Address: Each instrument at your facility must have an IP address. An IP address is a string of four
integer numbers between 0 and 255 separated by periods.

Port: The location of the instrument to which you send data and from which you receive data.

HL7 Inst ID: The instrument ID in HL7 messages that identifies the instrument. The ID is provided by
the vendor.

HL7 Unv Svc ID: The universal service ID for HL7 messages identifies the type of procedure the
instrument performs when the instrument is capable of performing more than one procedure.

HL7 Link: There is one unique HL7 link for each instrument.

6.3. Working with Parameters
Parameters are set with CP Console.
You can configure the following items:

e CPADT Feed

e CP Gateway Configuration,

e CP Parameters
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= 3 CP Console
&) (_] Background Task
) [_] Flowsheet
- |_] Flowsheet Total
) [_] Flowsheet Yiew
- [] Instrument

=28
CP ADT Feed Configuration
ﬁ CP Gateway Configuration
ﬂ CP Parameters
- (] Procedure
~|_] Schedule

(2 Shift

[+

Figure 6-7, CP Console Parameters

6.3.1. CP Parameters

Clinical Procedures system parameters affect all the procedures and instruments. You need to set the
common parameters.

Clinical Procedures Common Parameter Set

Clinical Procedures Home Page: ivista.med.va.gov/CIinicaISpecialﬁes/dinproc/ ‘
Imaging Network Transfer Directory: gc:\oocuments and Settings\DKoya'\Desktop ‘ Q
Observation Retrieval Batch Size (Records): ’ 20 |2
Unverifed Observation Retention (Days): ]7757‘ :
Instrument Date Retention (Days): 5 :

Clinical Procedures System On Line

|

Allow External Attachments
Bypass CRC Check

[] cache Terminology Files
Network Path:

I[j

Notification Lists ...

Figure 6-8, Clinical Procedures Common Parameter Set
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6.3.2. Administering Notification Lists
A notification list editor is a tool that is part of the Clinical Procedures Common Parameter Set.

If you experience HL7 errors, the Notification List editor allows you to send a message to the specified
member.

To administer notification lists:
1. Click the Notification Lists button.

Notification List Editor
Notification List:

Name:

CP Administrators v l

Members:
| CPAdmin.One@VA.Gov

Test

Save List

0]

Figure 6-9, Notification List Editor
In the Name list, select the list to edit. The members of the list appear in the Members box.
Use the Add, Edit, Remove buttons to edit the list.
Use the Save List button to save the list.

o &~

Use the Test button to send a test message to the members of the list.

The following are some additional terms specific to the Clinical Procedures Common Parameter Set:

Clinical Procedures Home Page: The Clinical Procedures Home page appears and directs the browser to
this page when accessed. The data in this field is predefined.

Imaging Network Transfer Directory: This is the path to the Imaging network directory used for
transferring data.

Use E] to browse to the appropriate location in the directory.
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Observation Retrieval Batch Size (Records): The number of database (DB) records to pull at one time.
Use the arrows to select a number of DB records to include in the batch.

Unverified Observation Retention (Days): The number of days to keep the unverified observations
before purging.
Use the arrows to select the number of days to retain unverified data.

This is a CLIO Cleanup task.

Instrument Data Retention (Days): The number of days to keep data from an instrument before
purging.
Use the arrows to select the number of days to retain instrument data.
This is a CP Cleanup task.

Clinical Procedures System On Line: The Clinical Procedure System On Line check box allows you to
restrict access to Clinical Procedures.
e Select the check box to indicate Clinical Procedures is offline.
e Clear the check box to indicate Clinical Procedures is online.

Offline Message: When the Clinical Procedure System On Line check box is not selected, type a note
in the Offline Message box to display when Clinical Procedures is offline.

Allow External Attachments: This affects Legacy CP. This allows you to find external attachments.
e Select the Allow External Attachments? check box to allow external attachments.
e Clear the Allow External Attachments? check box to not allow external attachments.

Bypass CRC Check: Bypass the Cyclical Redundancy Check during startup. On the server you can
check the checksum of the running application to verify that it is the same as the checksum of the
application distributed; the checksum value is associated with the version number of the software.

e Select the Bypass CRC Check? check box to perform the verification.
e Clear the Bypass CRC Check? check box to not perform the verification.

Note: If the checksum values do not match, a message appears indicating the values do not
match.

Cache Terminology Files: This is the path to the network directory used for caching terminology files.

Use E] to browse to the appropriate location.
Notification Lists: Administer the lists used for notification.

6.4. CP ADT Feed Configuration

The ADT (Admission/Discharge/Transfer) system allows VistA to notify third party devices (outgoing
data to devices) that a patient was admitted, discharged, or transferred. ADT feed acts as an event
handling system. You must configure the dynamic routing system, so that HL7 knows to which system to
deliver the ADT messages. Link an ADT target to a protocol. For more information on configuring the
CP ADT Feed, refer to the CP Flowsheets Module V1.0 Installation Guide.

Note: The subscriber protocol (MD DGPM PATIENT MOVEMENT) is provided and you must
add it to the ITEM multiple of the DGPM MOVEMENT EVENTS entry in the protocol file. This
allows the ADT feed to receive notification of patient movement.
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Current ADT Targets

Name Protocol Division ‘Ward Mo | Ev... |8 MNew...
MDSPLOO1 MDSPLOO1 CHEYENNE YAMROC  ICU-S ADT  AO1
MDSPLOD2 MDSPLOO1 CHEYENNE YAMROC  ICU-S ADT  AD2
MDSPLOOS MDSPLOO1 CHEYEMNNE YAMROC  ICU-S ADT A0
MDSPLO11 MDSPLOO1 CHEYENNE YAMROC  ICU-S ADT All
MDSPLO12 MDSPLOO1 CHEYENNE VAMROC ICU-S ADT Al2
MDSPLO13 MDSPLOO1 CHEYENNE YAMROC  ICU-S ADT  AL3
MDSPLAD3 MDSPLOO1 CHEYENNE YAMROC  ICU-S ADT  AO3
MDSPLO0Z_A01 MDSPLO0Z CHEYENNE YAMROC  ICU-S ADT A0t
MDSPLO0Z_A02 MDSPLO02 CHEYENNE YAMROC  ICU-S ADT A0Z
MDSPLO0Z_AD3 MDSPLO0Z CHEYENNE YAMROC  ICU-S ADT A03
MDSPLO0Z_ADS MDSPLOOZ CHEYEMNNE VAMROC ICU-S ADT A0S
MDSPLO0Z_A11 MDSPLO0Z CHEYENNE YAMROC  ICU-S ADT  All
MDSPLO0Z_A12 MDSPLO02 CHEYENNE YAMROC  ICU-S ADT  Al2
MDSPLO0Z_A13 MDSPLO0Z CHEYENNE YAMROC  ICU-S ADT  Al13
MDCHAD_a01 MDCHAD CHEYENNE VAMROC ECU ADT A01
MDCHAD_A02 MDCHAD CHEYENNE YAMROC ECU ADT A2
MDCHAD_A03 MDCHAD CHEYEMNNE VAMROC ECU ADT A03
MDHOMEY-A01 MDHONEY CHEYENNE YAMROC  ICU-S ADT  AO1L
MDHOMEY-ADS MDHONEY CHEYEMNNE YAMROC  ICU-S ADT A0
MDHOMEY-A011 MDHONEY CHEYENNE YAMROC  ICU-S ADT  All
MDHOMEY-A012 MDHONEY CHEYENNE VAMROC ICU-S ADT Al2
MDHOMNEY-A013  MDHOMEY CHEYENNE YAMROC ICU-S  ADT  A13 ¥

Figure 6-10, ADT Feed Configuration

6.4.1. Current ADT Targets

To remove an ADT target, highlight a line and click Delete Selected.

The following are definitions specific to ADT Targets:
Name: Name of the site

Protocol: Name of the subscriber protocol

Division: Division location of patient

Ward: Ward location of patient

Message Type: ADT

Event Type: ADT outbound (from VistA) message types
e A0l Admit/visit notification
e A02 Patient transfer
e AO03 Discharge/end visit
e A08 Update patient information
e All Cancel admission
e Al12 Cancel transfer
e A13 Cancel discharge/end visit

6.4.2. Adding an ADT Target

Use the Add ADT Target window to link an ADT target to a protocol. To add an ADT target:
1. Highlight Parameters in the tree view.

2. Select CP ADT Feed Configuration. The Current ADT Targets window appears.
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3. On the Current ADT Targets window, click New. The Add ADT Target window appears.

. .
4 Add ADT Target (=13
Protocol: Division: Protocol Link Name:
Name h tﬁ\SPER [
MDC ADT_a01 OUTE... +- CHEYENNE YAMROC
MDC ADT_ADZ OUTE... FORT COLLINS HL7 Message Type:
MDC ADT_AD3 OUTE... GREELEY =
MDC ADT_A11 OUTE. .. SIDNEY ADT ™
MDC ADT_A12 OUTE...
MDC ADT_A13 OUTE... HL7 Event Type:
MDCHAD [ — 7
MDHL Device Client !
MDHONEY
MDSPLOO1
MDSPLOOZ

Figure 6-11, Add ADT Target
4. From the Protocol list, select a protocol by name.

From the Division tree view, select an entire division or a ward within a division.
(This allows Clinical Flowsheets to filter outbound messages by patient location.)

In the Protocol Link Name box, type the protocol link name.

In the HL7 Message Type drop-down, ADT is the default.

From the HL7 Event Type drop-down list, select an ADT outbound message type.
Click OK.

© o N o

Example

Protocol: MDSPL001

Division: CHEYENNE VAMROC>C MEDICINE

The MDSPLO001 protocol receives the ADT A01 message only if the patient is moved, transferred, or
discharged from the C MEDICINE location.

10. Repeat steps 4-9 for each HL7 event type you need to link.

6.5. CP Gateway Service Configuration

You must install the CP Gateway Service and configure the VistA server settings and the Gateway server
settings for messaging to take place between VistA notification and ICU devices.

The CP Gateway Service exists as two subsystems, one solely within VistA, and the other as a Windows
service that interacts with VistA by way of the RPC Broker. For more information on configuring the CP
Gateway Service, refer to the CP Flowsheets Module V1.0 Installation Guide.

Use Gateway Server Settings to configure the gateway to restart automatically when the computer goes
down.
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YistA Server Settings
Access Code: |seeessss RPC Broker Port: | xuxx &
Verify Code: |sesesssss IP Address: |wxxxs

Gateway Server Settings

IP Address: Motify Port:
RHEKKK 8388 =
Log Level: Loqg Directory:
Critical X
Days To Retain Data:CP/Imaging Xfer Directory:
14 = AGateway
Data Refrieval Mechanism: Polling Interval
|VistA Notification v | sec.

Figure 6-12, CP Gateway Configuration Settings

6.5.1. VistA Server Settings
These settings allow the Gateway Service to restart automatically:

Access Code: Access code for the VistA service account with RPC Broker Context for CP Gateway (for
more details. refer to the CP Flowsheets Module V1.0 Installation Guide)

Verify Code: Verify code for the VistA service account with RPC Broker Context for CP Gateway (for
more details, refer to the CP Flowsheets Module V1.0 Installation Guide)

VistA server address settings are stored on the workstation in the system registry. They allow the CP
Gateway Service to connect to the appropriate VistA system at startup.

RPC Broker Port: Port on which the CP Gateway Service connects to the broker

IP Address: IP address at which the CP Gateway Service connects to the VistA system

6.5.2. Gateway Server Settings

The following are definitions specific to the Gateway Server:

IP Address: Each server must have an IP address. An IP address is a string of numbers with format:
XX.XX.XX.XxX. IP address of the workstation on which the CP Gateway Service is installed.

Notify Port: The listening port of the local machine. The port must be open when sending a message to
the workstation. The default is 8888.

Log Level: The level of detail to log in the Windows Event Viewer for the CP Gateway Service.
e Critical — severe errors only
e Error —critical + errors that cause instability in the operation of the Gateway Service
e \Warning — critical + error + any items captured but allowed the Gateway Service to
continue running
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o Detail — critical + error + warning + detailed execution trail of everything that the
Gateway Service does as it processes HL7 messages

Log Directory: The log file tracks all the background operations and any problems that occur during
processing. This is the directory in which the CP Gateway Service stores the logs.
Type in the location of the log directory.
The default directory for the log file is C:\

Days to Retain Data: The number of days to allow processed messages to remain in the log prior to
purging. After the number of days indicated, the data is purged during HL7 Log Cleanup.
e Use the arrows to set the number of days to retain messages.
o Leave the field empty or at O to retain the data indefinitely.

CP/Imaging Xfer Directory: This is the directory in which Imaging stores CP transfer data.

Data Retrieval Mechanism: The method to use for data retrieval-your data source: VistA Notification
or Polling.
Set the interval to VistA Notification. In VistA Notification, the VistA server will automatically
notify the CP Gateway whenever a message arrives that requires processing. This is the preferred
setting. Sometimes, however, local business requirements dictate that the Polling option be used.
This option acts like the legacy CP Gateway, in that the CP Gateway will be polled periodically
for data to process.

Polling Interval: The CP Gateway Service polls for new instrument data to transmit to VistA.
When you select Polling as the data retrieval mechanism, use the arrows to set the number of
seconds between polling operations. A new value becomes effective after the next polling
operation.

6.6. Working with Procedure Information

Legacy procedure information is populated through the CP DEFINITION file (#702.01), but you need to
populate additional fields to complete the process. You can add new procedures and modify existing
procedures. In order to use a procedure in a flowsheet, you must select the Active check box to activate it.
Also, you need a primary key (MD ADMINISTRATOR or MD MANAGER) to edit and add procedures.
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General
Treating Specialy: Hospeol Location: TIL Note Thg:
[ B \ ; v | v
Description:
[New Procedure }
External Attachment Directory:
i
DRequire External Data Processing Application: Processed Results:
A
[] Auta Submit To Vista Imaging O Default (CP) (%) Final Result
[CIHigh Yolume Instrument 2 s O Multiple Results
Active O Hemodialysis O Cummulative Result

Allowable Instruments

Athena Hypertension - Athena Hypertension Device Interface 2
|

AWARE - GE AWARE Gateway

AXIOM Sensis - AXIOM Sensis Device Interface

AXIOM Sensis (Bi-Directional) - AXIOM Sensis Device Interface &

Figure 6-13, Edit Procedure

6.6.1. Adding a Procedure

Use the new procedure worksheet to add new procedures to CP Flowsheets. To add a procedure:

1. From the File menu, highlight New and select Procedure. The Create New Procedure pop-up
appears.

Create New Procedure @

Name:

[ OK H Cancel ]

Figure 6-14, Create New Procedure
2. Inthe Name box, type a name for the new procedure.
3. Click OK. The new Procedure worksheet appears.

The name appears in the tree view and as the Item Name at the top of the CP Console main window.
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General
Trreatinﬂgggercialty:r - Hqui;al Location: ~ TIU Mote Title:
v v v
Description:
New Procedure
External Attachment Directory:
[JRequire External Data Processing Application: Processed Results:
A
[] Auta Submit To Vista Imaging O Default (CP) () Final Result
[CIHigh Yolume Instrument ™ s O Multiple Results
Active © Hemadialysis O Cummulative Result

Allowable Instruments

Athena Hypertension - Athena Hypertension Device Interface 2
AWARE - GE AWARE Gateway

AXIOM Sensis - AXIOM Sensis Device Interface

AXIOM Sensis (Bi-Directional) - AXIOM Sensis Device Interface 3

Figure 6-15, Procedure Worksheet

6.6.2. Modifying an Existing Procedure

Use the Procedure worksheet to modify the parameters of an existing procedure. To modify an existing
procedure:

1. Inthe tree view, highlight and expand the Procedure folder.

2. Select a procedure from the list.

3. Make the necessary changes to one or more of the fields of the procedure worksheet.
4. Click Save.
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6.6.3. Procedure Definitions
The following are definitions specific to Procedure:

Treating Specialty: This is the specialty under which the procedure falls. The list comes from the
TREATING SPECIALTY file (#45.7).

# CP Console =

File Tools Help

- & Rename - Search ... =8 Perrissions ...

= {23 CP Cansale

+1-((] Background Task
4[] Flowsheet

+- 1 Flowsheet Tatal
+- [ Flowsheet Wiew
+-[1 Instrument
+-[1 Parameters

Item Mame: COLONOSCOPY

Type:
Access LeveFull Control

Procedure

General

Treating Specialty: Hospital Location:

TIU Mote Title:

223 Procedure MECICAL OBESERMATION | (345 L TP COLOMOSCOPRY w
Description:
Colonoscopy
External Attachment Directory:
B DK Procedure Yimedseryicolonascopy
B oK1 N
B Heart Cath Require External Data Processing Application: Processed Resulks:
B HEART CATH Aukn Subit T Yists Tmaging (3) DeFaulk (CP) ® Flna! Result
B NEW PROCEDURE [ High ¥olume Instrument o O Mulkiple Resuls
(3 Schedul Active O Hemodialysis © Cumulative Result
+ Chedule
-] Shift Allowable Instruments
Athena Hypertension - Athena Hypertension Device Interface K
AWARE - Mew Instrurment
AWARE - Mew Instrurment
AWARE - GE AWARE Gateway w

Figure 6-16, Treating Specialty

Hospital Location: The location in the hospital in which the procedure is performed. The list comes from
the HOSPITAL LOCATION file (#44); workload credit for the procedure is tracked through
hospital location.

TIU Note Title: The title of an appropriate note with which to reference the active procedure. The list
comes from the TIU DOCUMENT file (#8925). This must be a Generic TIU Note title.

Description: This is information describing/identifying the procedure.

External Attachment Directory: This is the directory in which you find attachments. If you select the
Require External Data check box, type in the path to the location of the data, or browse to locate a
directory.

Require External Data: The procedure requires external attachments, such as an independent report
from another facility.

Auto Submit to VistA Imaging: Automatically submit to VistA Imaging when the procedure is
processed by a bi-directional instrument and additional data does not need to be matched. When
the check box is not selected, the study is in the Ready to Complete status.

High Volume Instrument: A medical device that sends over 200 observations per day.

Note: The High Volume Instrument option is not active in this release of Flowsheets. It will be
active in the next release
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Active: The procedure is active and available in CP Flowsheets.
e Select the Active check box to make the procedure active and available.
o Clear the Active check box to inactivate the procedure.

Note: If the Active check box is not selected, you cannot use the procedure in your flowsheets.
In the tree view, an active procedure appears B.

MEW PROCEDURE

test1
test2

Figure 6-17, Active Procedure

Processing Application: Select one application that performs the processing.
e Default (CP)—Clinical Procedures
e Hemodialysis—Hemodialysis package

Processed Results: Processed results indicate whether a final result, multiple results, or a cumulative
result is associated with a particular procedure.
Select one type of result.
e Final Result—default
e Multiple Results—allows creation of a new TIU note for each result sent back
e Cumulative Result-allows a multiple-result device to continuously send results back to the
same TIU note

6.6.4. Allowable Instruments

Allowable instruments are a list of instruments providing results for the procedure which appear in the
Allowable Instruments group box. If you want to use an external attachment, do not select any
instruments.

6.6.5. Working with the Procedure Worksheet

To make a procedure available in CP Flowsheets, complete the following steps:

1. Click inside the Treating Specialty drop-down list, and type an alpha character, such as ¢, t, or n, at
which you want the list of specialties to begin.

2. From the Hospital Location drop-down list, select a hospital location. Click in the box and type an
alpha character, such as c, t, or n, at which you want the list of locations to begin.

3. From the TIU Note Title drop-down list, select a note title to display in CPRS. Click in the box and
type an alpha character, such as c, p, or n, at which you want the list of note titles to begin.

4. In the Description box, enter comments to describe the procedure.
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5. Select the Require External Data check box for the procedure to allow external attachments.

General
Treating Specialty: Hospital Location: TIU Make Title:
|CARDIAC INTENSIVE CARE UM + | |CT CLINIC v | |PFT <cPPFT> v |
Descripkion:

|C|:|I|:|n|:|sc|:|py |

External Attachment Directory:

|'|,'|,medserv'l,cu:ulu:unnscnpy |
Require External Data Processing Application: Processed Results:

Auto Submit To Yisks Imaging (%) Default (TP ® F""a! Result

[ JHigh Yolume Instrument o O Multiple Resulks

active O Hemodialysis ) Cumulative Result

Figure 6-18, Procedure Worksheet

6. If you select the Require External Data check box, enter the path to the location of the data, or
browse to locate a directory in the External Attachment Directory field.

7. Select the Auto Submit to VistA Imaging check box to automatically submit the study to VistA
Imaging.

8. Select the High Volume Instrument check box for a frequently used instrument.
9. To make the procedure available in CP Flowsheets, select the Active check box.
10. From the Processing Application options, select either Default (CP) or Hemodialysis.

11. From the Processed Results options, select one: Final Result, Multiple Results, or Cumulative
Result.

6.6.6. Adding Allowable Instruments

To add instruments for a procedure:

1. From the Allowable Instruments list, select all instruments that provide results for the procedure.

Allowable Instruments

Athena Hypertension - Athena Hyperkension Device Interface 4
v |

B awaRE - New Instrument

AWARE - GE AWARE Gakeway L

Figure 6-19, Allowable Instruments
2. Click Save.
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7. Shortcut Keys

When you first open CP Console, you can use Tab and the arrow keys to maneuver through the main

window.

The following is a list of shortcut keys for the CP Console main window.

Option/Text Shortcut  Action/Opens
Alt, F Sets up for shortcuts

File menu Alt, | Opens the File menu
New N

Flowsheet F

Flowsheet Total @)

Flowsheet View L

Instrument I

Procedure P

Schedule C

Shift S
Rename R
Delete D
Save S
Exit E
Tools menu Alt, T Opens the Tools menu
Search S
Permissions P
Refresh Roles R
Export To XML E
Import From XML |
Help menu Alt, H Opens the Help menu
About A Application information
Contents C Online help
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8. Glossary

This glossary is used for the Clinical Flowsheets project and may include terms and definitions not used

in this specific document.

Term

Description

<RET>

Carriage return.

IAccess Code

/A unique sequence of characters known by and assigned only to the user, the system
manager and/or designated alternate(s). The access code (in conjunction with the
wverify code) is used by the computer to identify authorized users.

Action

/A functional process that a clinician or clerk uses in the TIU computer program. For
example, “Edit” and “Search” are actions. Protocol is another name for Action.

ADP

IAutomated Data Processing

IADP Coordinator/-
IADPAC/Application
Coordinator

IAutomated Data Processing Application Coordinator. The person responsible for
implementing a set of computer programs (application package) developed to support
a specific functional area such as clinical procedures, PIMS, etc.

ADT

IAdvanced Data Type (InterSystems Cache). Also Admissions, Discharges, Transfers.

AP

/Arterial pressure

AP

IApplication Programming Interface. An interface that a computer system, library, or
application provides in order to accept requests for services from other programs,
and/or to allow data to be exchanged between them.

Application

/A system of computer programs and files that have been specifically developed to
meet the requirements of a user or group of users.

IArchive

'The process of moving data to some other storage medium, usually a magnetic tape,
and deleting the information from active storage in order to free-up disk space on the
system.

IAssessment

IAssessment is the documentation of a clinician’s observations and interpretation of a
patient’s clinical state based on a particular set of observations. The documentation is
in the form of name-value pairs with values selected from a predetermined set, of
name-value pairs in which the value is a number or set of numbers, or of free text.
Examples of assessments from paper ICU flowsheets are coma scale, patient opens
eyes, pupil size, reaction to light, and so on.

ASU

IAuthorization/Subscription Utility. An application that allows sites to associate users
with user classes, allowing them to specify the level of authorization needed to sign or
order specific document types and orderables. ASU is distributed with TIU in this
version; eventually it will probably become independent, to be used by many VistA
packages.

IAttachments

Attachments are files or images stored on a network share that can be linked to the CP
study. CP is able to accept data/final result report files from automated instruments.
The file types that can be used as attachments are the following:

.txt - Text files

.rtf - Rich text files

.jpg - JPEG Images

.jpeg - JPEG Images

.bmp - Bitmap Images

tiff - TIFF Graphics (group 3 and group 4 compressed and uncompressed types)

.pdf - Portable Document Format

.html - Hypertext Markup Language

.DOC (Microsoft Word) files are not supported. Be sure to convert .doc files to .rtf or
to .pdf format.
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Term

Description

Background Processing

Simultaneous running of a "job™ on a computer while working on another job.
Examples would be printing of a document while working on another, or the software
might do automatic saves while you are working on something else.

Background Task

/A job running on a computer while simultaneously working on a second job.

Backup Procedures

'The provisions made for the recovery of data files and program libraries and for restart
or replacement of ADP equipment after the occurrence of a system failure.

Boilerplate Text

/A pre-defined TIU template that can be filled in for Titles, Speeding up the entry
process. TIU exports several Titles with boilerplate text which can be modified to
meet specific needs; sites can also create their own.

BP Blood Pressure.

Broker Software which mediates between two objects, such as a client and a server or a
repository and a requestor.

Browse Lookup the file folder for a file that you would like to select and attach to the study.
(e.g., clicking the “...” button to start a lookup).

Bulletin /A canned message that is automatically sent by MailMan to a user when something

happens to the database.

Business Rule

Part of ASU, Business Rules authorize specific users or groups of users to perform
specified actions on documents in particular statuses (e.g., an unsigned CP note may
be edited by a provider who is also the expected signer of the note).

CAC Clinical Application Coordinator.

Care Action Care action is an intervention scheduled on a patient that may or may not be ordered.

CCB Change Control Board.

CCDSS Clinical Care Delivery Support System.

CCOW Clinical Context Object Workgroup. An HL7 standard protocol through which
applications can synchronize in real-time, enabling Single Sign On and Context
Management.

CDR Clinical Data Repository.

CIS Clinical Information System. An ICU Clinical Information System is any
hardware/software system that works in concert to collect, store, display, and/or
enable manipulation of potential, clinically relevant information. A CIS also acts as an
HL7 Gateway. Vendors of monitors and other instruments used in an ICU provide the
CIS. The primary distinguishing feature of this CIS is its ability to manually select a
subset of all available data and send it to the EMR.

Class Part of Document Definitions, Classes group documents. For example, “CLINICAL

IPROCEDURES?” is a class with many kinds of Clinical Procedures notes under it.
Classes may be subdivided into other Classes or Document Classes. Besides grouping
documents, Classes also store behavior which is then inherited by lower level entries.

Clinical Flowsheets

A module of the Clinical Procedures package that allows the collection of discrete
data from medical devices or a Clinical Information System. It is a complete HL7
standardized instrument interface developed and owned by the Department of
\Veterans Affairs. This module is comprised of three components: the CP Flowsheets
application, the CP Console application, and the CliO Generic Interface.

Clinical Reminders

/A system which allows caregivers to track and improve preventive healthcare and
disease treatment for patients and to ensure timely clinical interventions.

CliO Clinical Observations database.
CM Configuration Management.
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Term

Description

Consult

Referral of a patient by the primary care physician to another hospital service/
specialty, to obtain a medical opinion based on patient evaluation and completion of
any procedures, modalities, or treatments the consulting specialist deems necessary to
render a medical opinion.

Contingency Plan

/A plan that assigns responsibility and defines procedures for use of the
backup/restart/recovery and emergency preparedness procedures selected for the
computer system based on risk analysis for that system.

CP Clinical Procedures.

CP Console /An application used by Administrators to configure the CP Flowsheets application and
its interface settings.

CP Definition CP Definitions are procedures within Clinical Procedures.

CP Flowsheets

A GUI component of the Clinical Flowsheets package. Its primary functions are to
provide a means to display data collected from a medical device and to allow manual
entry of data. Additional functionality is provided to display and print reports, verify
incoming observational data, add comments, correct erroneous information, and
submit TIU Notes to CPRS.

CP Gateway 'The service application that prepares the data contents of HL7 messages for use in CP
Hemodialysis. It requires no direct user interaction.

CP Manager 'The CP Manager application is no longer supported after the installation of
MD*1.0*16; it has been superseded by CP Console.

CP Study /A CP study is a process created to link the procedure result from the medical device
or/and to link the attachments browsed from a network share to the procedure order.

CPRS Computerized Patient Record System. A comprehensive VistA program, which allows

clinicians and others to enter and view orders, Progress Notes and Discharge
Summaries (through a link with TIU), Problem List, view results, reports (including
health summaries), etc.

Data Dictionary

/A description of file structure and data elements within a file.

DBIA

Database Integration Agreement.

Delphi

/A programming language, also known as Object Pascal.

Device

/A hardware input/output component of a computer system (e.g., CRT, printer).

Display Interval

'The amount of time that displays in each column of a flowsheet view. Display interval
is configurable from 1 minute to 24 hours. Shorter interval settings can improve
readability when a large amount of data is received over a short period of time. Longer
interval settings allow you to view longer periods of time while reducing the amount
of horizontal scrolling necessary to view all columns.

DLL

Dynamically Linked Library. These files provide the benefit of shared libraries.

DOB

Date of Birth.

Document Class

Document Classes are categories that group documents (Titles) with similar
characteristics together. For example, Cardiology notes might be a Document Class,
with Echo notes, ECG notes, etc. as Titles under it. Or maybe the Document Class
would be Endoscopy Notes, with Colonoscopy notes, etc. under that Document Class.

Document Definition

Document Definition is a subset of TIU that provides the building blocks for TIU, by
organizing the elements of documents into a hierarchy structure. This structure allows
documents (Titles) to inherit characteristics (such as signature requirements and print
characteristics) of the higher levels, Class and Document Class. It also allows the
creation and use of boilerplate text and embedded objects.

DUZ Designated user. This is the internal FileMan number for a particular user.
Edit Used to change/modify data typically stored in a file.
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EMR Electronic Medical Record. HealtheVet, is the permanent medical record for a patient
in VistA

Field /A data element in a file.

File 'The M construct in which data is stored for retrieval later. A computer record of

related information.

File Manager or FileMan

\Within this manual, FileManager or FileMan is a reference to VA FileMan. FileMan is
a set of M routines used to enter, edit, print, and sort/search related data in a file, a
database.

File Server

/A machine where shared software is stored.

Flowsheet

/A flowsheet is a table, chart, spreadsheet, or other method of displaying data on two
axes. One axis represents time intervals and the other axis represents the readings from
an ICU monitor documented at the various time intervals.

Clinical Flowsheet

Coordinator

Primary liaison for implementation, maintenance, and evaluation of the CP Flowsheet
application at the facility level.

Flowsheet view

/A customizable subsection (or page) of a flowsheet. Flowsheet views are created by
adding and arranging terms and choosing their default qualifiers. Flowsheet views can
be set up to display observations, provide a way to manually enter observations, and
display reports.

Fluid off Cumulative volume of fluid removed from patient.

Gateway 'The software that performs background processing for Clinical Procedures.

Global An M term used when referring to a file stored on a storage medium, usually a
magnetic disk.

GUI Graphical User Interface. A Windows-like screen that uses pull-down menus, icons,
pointer devices, and other metaphor-type elements that can make a computer program
more understandable, easier to use, allow multi-processing (more than one window or
process available at once), etc.

HDR Health Data Repository.

HEP (CUM) Cumulative heparin infusion

HFS Host File System.

HIPAA Health Insurance Portability and Accountability Act.

HL7 Health Level 7. A language which various healthcare systems use to interface with one

another.

HL7 Gateway

Hardware or software provided by a vendor that is able to receive information in a
vendor’s proprietary format from one or more ICU monitors and other instruments, to
translate the data into standardized HL7 message format, and to pass the messages to
other systems.

HR Heart Rate.

HSD&D Office of Information (OI), Health Systems Design & Development.

HSITES Health Systems Implementation, Training, Education, and Support.

ICU Intensive Care Unit.

IEN Internal Entry Number.

1J Internal Jugular.

Instrument /An instrument is a device used to perform a medical function on a patient. In Clinical
Flowsheets instrument refers to ICU monitors, which are electronic devices that
collect and/or display information concerning the physical state of a patient. Usually,
the monitor attaches to a patient and takes readings over time without requiring
intervention for each reading.
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Interpreter Interpreter is a user role exported with USR*1*19 to support the Clinical Procedures
Class. The role of the Interpreter is to interpret the results of a clinical procedure.
Users who are authorized to interpret the results of a clinical procedure are sent a
notification when an instrument report and/or images for a CP request are available for
interpretation. Business rules are used to determine what actions an interpreter can
perform on a document of a specified class, but the interpreter themselves are defined
by the Consults application. These individuals are ‘clinical update users’ for a given
consult service.

IRM Information Resource Management.

IRMS Information Resource Management Service.

JCAHO Joint Commission on Accreditation of Healthcare Organizations.

Kernel /A set of software utilities. These utilities provide data processing support for the
application packages developed within the VA. They are also tools used in
configuring the local computer site to meet the particular needs of the hospital. The
components of this operating system include MenuMan, TaskMan, Device Handler,
Log-on/Security, and other specialized routines.

Key A level of access assigned to a Flowsheets user that determines which Flowsheets
functions the user may perform. Refer to “User Role” in this Glossary.

LAYGO /An acronym for Learn As You Go. A technique used by VA FileMan to acquire new
information as it goes about its normal procedure. It permits a user to add new data to
a file.

LPES/CPS Legacy Product Enterprise Support/Clinical Product Support. Enterprise Product
Support (formerly Enterprise VistA Support).

log /A list that provides the time and description of events as they occur.

M Formerly known as MUMPS or the Massachusetts (General Hospital) Utility Multi-
Programming System. This is the programming language used to write all VistA
applications.

MailMan /An electronic mail, teleconferencing, and networking system.

MAP Mean Arterial Pressure.

Menu /A set of options or functions available to users for editing, formatting, generating
reports, etc.

Module /A component of a software application that covers a single topic or a small section of
a broad topic.

MUMPS Massachusetts General Hospital Utility Multi-Programming System. Obsolete; now
known as "M" programming language.

Namespace /A naming convention followed in the VA to identify various applications and to avoid

duplication. It is used as a prefix for all routines and globals used by the application.

Network Server Share

/A machine that is located on the network where shared files are stored.

Notebook This term refers to a GUI screen containing several tabs or pages.

NTE Not To Exceed.

Ol Office of Information. Formerly known as Chief Information Office Field Office,
Information Resource Management Field Office, and Information Systems Center.

option A functionality that is invoked by the user. The information defined in the option is

used to drive the menu system. Options are created, associated with others on menus,
or given entry/exit actions.

optional page

One of two special types of flowsheet views which provides a way to track a specific
condition (e.g., a pacemaker) on its own flowsheet view. An Optional Page can
display only once in a given flowsheet. If an optional page is closed and then
redisplayed, any data previously entered still displays.

August 2011

Clinical Procedures (CP) Flowsheets Module V1.0 91
Implementation Guide



Glossary

Term Description

Package Otherwise known as an application. A set of M routines, files, documentation and
installation procedures that support a specific function within VistA.

page This term refers to a tab on a GUI screen or notebook.

Password /A protected word or string of characters that identifies or authenticates a user, a
specific resource, or an access type (synonymous with Verify Code).

PCE Patient Care Encounter.

PD Product Development

Permission Setting that can be used to allow access to particular views, flowsheets, etc. to one or
more specific users and to control the type of access each user has.

PIMS Patient Information Management System.

Pivot Swap the axes of a table or chart. This causes the values that were displayed along the
\vertical axis to be displayed along the horizontal axis and the values that were
displayed along the horizontal axis to be displayed along the vertical axis.

PM Project Manager.

Pointer /A special data type of VA FileMan that takes its value from another file. This is a
method of joining files together and avoiding duplication of information.

PRN /As needed.

Procedure Request

IAny procedure (EKG, Stress Test, etc.) which may be ordered from another
service/specialty without first requiring formal consultation.

Program /A set of M commands and arguments, created, stored, and retrieved as a single unit in
M.

Protocol /A set of rules governing communication within and between computing endpoints.

PS Provider Systems.

PV Pulmonary Vascular.

QG Quality Gate.

Qualifiers /A word or phrase that provides specific information about an observation. For
example, an observation could have qualifiers such as Unit (f=degrees Fahrenheit,
c=degrees Celsius, bpm=beats per minute, rpm=respirations per minute, etc.), Method
(Cu=cuff BP, Dop=Doppler BP, etc.), Position (Ly=lying, Si=sitting, St=standing,
etc.), Location (La=left arm, LL=left leg, RA=right arm, RL=right leg, etc.), Quality
(A=accurate, E=Estimated), etc.

Queuing 'The scheduling of a process/task to occur later. Queuing is normally done if a task is a
heavy user of computer resources.

RAID Redundant Array of Inexpensive Disks. A data storage scheme using multiple hard
drives to share or replicate data among the drives.

Result /A consequence of an order. Refers to evaluation or status results. When you use the
Complete Request (CT) action on a consult or request, you are transferred to TIU to
enter the results.

Routine /A set of M commands and arguments, created, stored, and retrieved as a single unit in
M.

RPC Remote Procedure Call. A protocol that allows a computer program running on one
host to cause code to be executed on another host.

Rx Prescription.

SAC Standards And Conventions.

Security Key

/A function which unlocks specific options and makes them accessible to an authorized
user.
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Sensitive Information

Any information which requires a degree of protection and which should be made
available only to authorized users.

Service /A long-running executable designed to perform specific functions without user
intervention. Windows services can be configured to restart automatically when the
operating system is rebooted.

SGML Standard Generalized Markup Language.

Shift /A period of time that can be defined in CP Flowsheets. This often corresponds to the

time an individual an individual works.

Site Configurable

/A term used to refer to features in the system that can be modified to meet the needs of
each site

Software /A generic term for a related set of computer programs, such as an operating system
that enables user programs to run.

SQA Software Quality Assurance.

SRS Software Requirements Specification.

SSN Social Security Number.

Status Symbols Codes used in order entry and Consults displays to designate the status of the order.

STS Standards and Terminology Services. An initiative to create and maintain standardized

terminology throughout the VA by assigning a code to every term.

Supplemental page

One of two special types of flowsheet views which provides a way to track a specific
condition (e.g., a pressure wound) on its own flowsheet view. Multiple supplemental
pages can be added to a single flowsheet in order to track numerous specific
conditions. If a supplemental page is closed and then a new supplemental page is
added, the new supplemental page is blank.

Tab

One of the five primary GUI screens of the CP Flowsheets application: Flowsheet,
IAlarms, Reports, Log Files, and HL7 Monitor.

Task Manager or

/A part of Kernel which allows programs or functions to begin at specified times or

TaskMan when devices become available. See Queuing.

Term /As used in Flowsheets, a term is any piece of relevant data. A term, like “Blood
Pressure” will typically have one or more associated measures, modifiers, or
qualifiers.

Terminology Standardization of words and terms used in Flowsheets.

Title Titles are definitions for documents. They store the behavior of the documents which
use them.

TIU Text Integration Utilities.

TMP Trans Membrane Pressure.

UFR Ultrafiltration Rate.

Ul User Interface.

UNC Universal Naming Convention.

Untrusted device

/A medical instrument which has not been mapped for use with the Clinical Flowsheets
package. Data sent from an untrusted device will not display in a flowsheet view until
someone reviews it (on the CP Flowsheets Log Files tab) and marks it as verified.

URL Uniform Resource Locator. A means of finding a resource (such as a web page or a
device) on the Internet.

URR Urea Reduction Ratio. The reduction in urea as a result of dialysis.

User /A person who enters and/or retrieves data in a system, usually utilizing a CRT.
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User Class User Classes are the basic components of the User Class hierarchy of ASU
(Authorization/Subscription Utility) which allows sites to designate who is authorized
to do what to documents or other clinical entities.

User Role User Role (in a documentation context). The role of the user with respect to the
document in question (e.g., Author/Dictator, Expected Signer, Expected Cosigner,
/Attending Physician, etc.).

User Role User Role (in a Flowsheets setup context). The role of a Flowsheets user with respect
to which Flowsheets functions the user will have permission to perform. Flowsheets
User Role include the following.
* MD ADMINISTRATOR
e MD MANAGER
» MD HL7 MANAGER
* MD READ-ONLY
* MD TRAINEE

Utility /An M program that assists in the development and/or maintenance of a computer
system.

UUEnNcoded format /A form of binary to text encoding whose name derives from "Unix-to-Unix encoding”.

VA Department of Veterans Affairs. Formerly the Veterans Administration.

VAMC Department of Veterans Affairs Medical Center.

'VDEF \VistA Data Extraction Framework.

Verify Code /A unique security code which serves as a second level of security access. Use of this
code is site specific. This term is sometimes used interchangeably the term password.

VHA \Veteran Health Administration.

VistA \Veterans Health Information Systems and Technology Architecture.

VP '\VVenous Pressure.

VUID \Veterans Health Administration (VHA) Unique Identifier. A unigque identifier that

specifies individual data elements or observations. In Clinical Flowsheets, each term is
assigned a VUID.

Workstation

/A personal computer running the Windows 9x or NT operating system.

XML Extensible Markup Language. A simplified subset of Standard Generalized Markup
Language (SGML). Its primary purpose is to facilitate the sharing of data across
different information systems.

XMS Extended Memory Specification. The specification describing the use of extended
memory in real mode for storing data.
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